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Εισαγωγή 

 

 Πολύ συχνά, στην καθημερινή κλινική πράξη, τίθεται το ερώτημα της 
επάρκειας της μηχανικής αντοχής των οστών. Λόγω όμως της έλλειψης κατάλληλης 
τεχνολογίας για την εξαγωγή αξιόπιστων μετρήσεων, η μηχανική αντοχή των οστών 
δεν μπορεί να εκτιμηθεί πειραματικά. Επιπρόσθετα, δεν μπορεί να υπάρξει μια 
πλήρης και αξιόπιστη εικόνα της κατανομής των τάσεων καθώς και των 
παραμορφώσεων που υφίστανται τα οστά όταν τους επιβληθεί κάποια ορισμένη 
φόρτιση. 

 Όσο δεν υπάρχει μέθοδος που να μπορεί με ακρίβεια να εκτιμήσει άμεσα τη 
μηχανική αντοχή των οστών (κάτω από δυναμικές συνθήκες καταπόνησης) σε ζώντα 
άνθρωπο, τα συμπεράσματα θα εξάγονται είτε από μετρήσεις, κάτω από διάφορες 
συνθήκες (πρόκληση καταγμάτων κλπ), στα οστά πειραματόζωων, είτε από 
παρατήρηση πτωματικών μεν, συντηρημένων δε, οστών από άνθρωπο. Αυτό έχει σαν 
αποτέλεσμα την εξαγωγή συμπερασμάτων με μεγάλα ποσοστά λάθους και σημαντική 
απόκλιση από την πραγματικότητα, γιατί, πρώτον, τα οστά των ζώων δεν 
παρουσιάζουν πολλές ομοιότητες με αυτά των ανθρώπων, και δεύτερον τα 
συντηρημένα οστά δε διατηρούν τις ίδιες ιδιότητες με αυτά των ζώντων οργανισμών. 

 Για τους λόγους αυτούς παρίσταται ανάγκη υπολογιστικής προσομοίωσης των 
ιδιοτήτων των οστών, και με την ανάπτυξη σύγχρονου λογισμικού, αυτό είναι πλέον 
εφικτό. Έτσι, η δημιουργία υπολογιστικών μοντέλων (με τη μέθοδο των 
πεπερασμένων στοιχείων), μπορούν να παρέχουν πρωτογενή αποτελέσματα τα οποία 
είναι αδύνατον να εξαχθούν με διαφορετικό τρόπο. 

 Στην παρούσα Διπλωματική εργασία, γίνεται διερεύνηση με σκοπό την 
εξαγωγή συμπερασμάτων όσον αφόρα στην κατανομή των τάσεων στη μεταταρσική 
περιοχή, αλλά και των παραμορφώσεων που λαμβάνουν χώρα σε διάφορους τύπους 
καταγμάτων στο 5ο μετατάρσιο. Για το σκοπό αυτό, δημιουργήθηκαν ολοκληρωμένα 
μοντέλα του πρόσθιου μέλους του ανθρώπινου ποδιού. Η μοντελοποίηση στηρίχτηκε 
κατά κύριο λόγο, σε πρόσφατες και αξιόπιστες μελέτες οι οποίες καταγράφονται 
εκτενώς στη Βιβλιογραφία. 

Περιληπτικά: 

Στο πρώτο κεφάλαιο, παρατίθεται μια σύντομη βιβλιογραφική αναφορά σε στοιχεία 
ανατομίας και φυσιολογίας των οστών. 

Στο δεύτερο κεφάλαιο γίνεται εκτενής περιγραφή της αρχιτεκτονικής του ποδιού. 

Στο τρίτο κεφάλαιο γίνεται μια συνοπτική αναφορά στη μέθοδο των πεπερασμένων 
στοιχείων. 
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Στο τέταρτο κεφάλαιο αναλύεται η διαδικασία που ακολουθείται για την απόκτηση 
της ζητούμενης τρισδιάστατης γεωμετρίας πάνω στην οποία γίνεται η 
μοντελοποίηση. 

Στο πέμπτο κεφάλαιο παρουσιάζεται πλήρες τρισδιάστατο μοντέλο πρόσθιου ποδιού 
και γίνεται περιγραφή των ιδιοτήτων και των συνθηκών φόρτισης. 

Στο έκτο κεφάλαιο παρουσιάζεται μια σύντομη βιβλιογραφική αναφορά στα 
κατάγματα καθώς και στο μηχανισμό επούλωσης τους. 

Στο έβδομο και τελευταίο κεφάλαιο παρατίθενται ολοκληρωμένα μοντέλα πρόσθιου 
ποδιού με 3 διαφορετικούς τύπους καταγμάτων στο 5ο μετατάρσιο. 
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ΚΕΦΑΛΑΙΟ 1ο 

 

 

ΣΤΟΙΧΕΙΑ ΑΝΑΤΟΜΙΑΣ, ΦΥΣΙΟΛΟΓΙΑΣ ΚΑΙ 

 ΜΗΧΑΝΙΚΗΣ ΣΥΜΠΕΡΙΦΟΡΑΣ ΤΩΝ ΟΣΤΩΝ 

 

 

 

 

Δομή. Μορφή. Μικροσκοπική θεώρηση δομής. Σύσταση. 

Αιμάτωση. Τύποι μηχανικής φόρτισης σε οστά. 
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1.1 Εισαγωγή 

 Τα οστά είναι ιδιαίτερα ενεργά όργανα, με πολύπλοκη αιμάτωση, θεμέλιο 
ουσία που αποτιτανώνεται και εξειδικευμένους κυτταρικούς πληθυσμούς οι οποίοι 
είναι υπεύθυνοι για τη συνεχή συντήρηση και ανακατασκευή τους. Δομικός τους 
ιστός, είναι ο οστίτης ιστός. 

Συνδέονται μεταξύ τους με τις αρθρώσεις, σχηματίζοντας έτσι τον σκελετό. 
Κύρια χαρακτηριστικά τους είναι η σκληρότητα και η αντοχή. Βασικές τους 
λειτουργίες είναι η προστασία και στήριξη των ευπαθών οργάνων, η παροχή 
περιοχών πρόσφυσης των μυών και η διευκόλυνση της δράσης των μυών και της 
κίνησης ολόκληρου του σώματος. 

 

1.2 Δομή των οστών 

Δομικός ιστός των οστών είναι ο οστίτης ιστός. Αποτελείται από ειδικού 
τύπου οστικά κύτταρα και μεσοκυττάρια ουσία. Παρουσιάζει μεγάλη σκληρότητα και 
αντοχή και χαρακτηριστική του ιδιότητα είναι η συνεχής απορρόφηση και δημιουργία 
νέου οστίτη ιστού, με σκοπό τη μεταβολή του μεγέθους και του σχήματός του, ώστε 
να υπάρχει διαρκής προσαρμογή στις εκάστοτε συνθήκες μηχανικής καταπόνησης 
των οστών. 

Από αρχιτεκτονικής άποψης, η δομή των οστών αποτελείται από δύο μορφές 
οστίτη ιστού, το εξωτερικό, συμπαγές ή φλοιώδες οστό (cortical) και το εσωτερικό, 
σπογγώδες ή δοκιδώδες οστό (cancellous). Το 80% των οστών αποτελείται από 
φλοιώδες οστό, που ουσιαστικά αποτελεί το περίβλημα μέσα στο οποίο περιέχεται το 
σπογγώδες οστό. 

 

            
 

Εικ. 1.1(α)                                                                 Εικ. 1.1(β) 

Εικόνα 1.1: (α) Φλοιώδες οστό (Φ), όπου αναγνωρίζονται οι κεντρικοί σωλήνες του Havers των 
οστεώνων (Η). Φαίνεται και το δοκιδώδες οστό (Δ). (β) Δοκιδώδες οστό (Δ) που περιβάλλεται από 

πυκνό φλοιώδες οστό (Φ). 
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Αξίζει να σημειωθεί, ότι ενώ το φλοιώδες και το σπογγώδες οστό δομούνται 
από τον ίδιο ιστό, τον οστίτη ιστό, είναι φανερό ότι διαφέρουν ως προς την 
αρχιτεκτονική τους δομή αλλά και ως προς την οστική τους πυκνότητα, συνεπώς 
παρουσιάζουν διαφορετική συμπεριφορά σε μηχανική καταπόνηση. 

 

1.3 Μορφή των οστών 

Η μορφή των οστών εξαρτάται άμεσα από την περιοχή που βρίσκονται αλλά 
και τη μηχανική λειτουργία που επιτελούν. Σύμφωνα με αυτό, η εκάστοτε μεταβολή 
μηχανικής καταπόνησης, συνεπάγεται πιθανή αλλαγή της γεωμετρίας τους άρα και 
των μηχανικών τους ιδιοτήτων. 

Διακρίνονται σε μακρά ή επιμήκη (π.χ. μετατάρσια), σε βραχέα (π.χ. 
σφηνοειδή) και σε επίπεδα (π.χ. ωμοπλάτη). 

Τα μακρά οστά αποτελούνται από το σώμα ή διάφυση και τα δύο άκρα τους 
ονομάζονται επιφύσεις, ενώ η σύνδεση με τα γειτονικά οστά γίνεται μέσω των 
αρθρικών επιφανειών των επιφύσεων. Η διάφυση αποτελείται από έναν εξωτερικό 
κύλινδρο φλοιώδους οστού, που περιβάλλει τον μυελικό αυλό και έχει μικρή 
ποσότητα σπογγώδους οστού. Στις επιφύσεις, το πάχος του φλοιώδους οστού 
λεπτύνεται και μεγάλη ποσότητα σπογγώδους οστού καταλαμβάνει τη μυελική 
κοιλότητα. 

Τα βραχέα οστά έχουν σχήμα κυβικό με πολλές αρθρικές επιφάνειες. Αποτελούνται 
από σπογγώδες οστό που περιβάλλεται από μία λεπτή επιφάνεια φλοιώδους. 

Τα επίπεδα οστά έχουν μία κυρτή επιφάνεια και μία κοίλη και το περιεχόμενό τους 
είναι σπογγώδες οστό το οποίο επίσης περιβάλλεται από μια λεπτή επιφάνεια 
φλοιώδους. 

 

1.4 Μικροσκοπική θεώρηση δομής 

Κατά την ανάπτυξη, οι οστεοβλάστες σχηματίζουν επιφάνειες από μη 
αποτιτανωμένη θεμέλιο ουσία, το οστεοειδές, πάνω στις επιφάνειες της ήδη 
αποτιτανωμένης θεμελίου ουσίας. Το οστεοειδές μεταλλώνεται αμέσως μετα το 
σχηματισμό του. Αποτελείται από ένα δίκτυο ινών κολλαγόνου τύπου I, που 
βρίσκεται σε ένα περιβάλλον από γλυκοζαμινογλυκάνες, οι οποίες περιέχουν ειδικές 
γλυκοπρωτεΐνες. Το οστεοειδές είναι μαλακό και εύπλαστο, παρουσιάζει μειωμένη 
μηχανική αντοχή και σε παθολογικές καταστάσεις που δε γίνεται μετάλλωσή του 
παρουσιάζονται παραμορφώσεις και κατάγματα. 

Ανάλογα με τον τρόπο που διατάσσονται οι ίνες κολλαγόνου για να 
σχηματίσουν το οστεοειδές, διακρίνονται δύο τύποι μεταλλωμένου οστού. Το 
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άμορφο ή δικτυωτό (ανώριμο, πρωτογενές, με ακανόνιστη διάταξη των ινών του 
κολλαγόνου και μετάλλωση) και το πεταλιώδες (ώριμο, δευτερογενές, με κανονική 
διάταξη των ινών κολλαγόνου και μετάλλωση). 

 

 

Εικόνα 1.2:  Δικτυωτό οστό (Δ) με τυχαία διάταξη και πεταλιώδες οστό (Π) με παράλληλη διάταξη των 
ινών κολλαγόνου. 

 

Το άμορφο βρίσκεται στον εμβρυικό και αναπτυσσόμενο σκελετό (μέχρι το 3-
4 έτος της ηλικίας) καθώς επίσης και στη μεταφυσική πλευρά της επίφυσης. Επίσης 
ανευρίσκεται σε περιπτώσεις αυξημένου οστικού μεταβολισμού όπως σε κατάγματα, 
μεταβολικά νοσήματα των οστών, νεοπλάσματα και φλεγμονώδεις παθήσεις. Το 
άμορφο οστό, αντικαθίσταται γρήγορα από ώριμο πεταλιώδες οστό, που παρουσιάζει 
μικρότερη μεταβολική δραστηριότητα και μεγάλη μηχανική αντοχή [1]. 

 

1.5 Σύσταση 

Ο οστίτης ιστός αποτελείται από 4 είδη κυττάρων, τα αδιαφοροποίητα 
κύτταρα, τα οστεοκύτταρα, τους οστεοβλάστες και τους οστεοκλάστες. 

Τα αδιαφοροποίητα κύτταρα (μικρά, μονοπύρηνα και με λίγα οργανίλια) 
βρίσκονται στα κανάλια των οστών, στο ενδόστεο και το περιόστεο, και αν δεχθούν 
κατάλληλο ερέθισμα διαφοροποιούνται σε οστεοβλάστες. Παρόμοια κύτταρα που 
μπορούν να παράγουν οστό συναντώνται και σε άλλους ιστούς. 

Τα οστεοκύτταρα αποτελούν το 90% των κυττάρων του ώριμου σκελετού. 
Έχουν ελλειψοειδές σχήμα και παρουσιάζουν μεγάλο αριθμό κυτταροπλασματικών 
προσεκβολών. Οι προσεκβολές σχηματίζουν δίκτυο, μέσω του οποίου, τους δίνεται η 
δυνατότητα επικοινωνίας με τα άλλα οστεοκύτταρα της αποτιτανωμένης θεμελίου 
ουσίας και με τους οστεοβλάστες των ελεύθερων επιφανειών και της οργανικής 
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θεμελίου ουσίας. Αυτή η επικοινωνία είναι σημαντική για την ομοιοστασία του 
ασβεστίου στον οργανισμό και για τη διακίνηση και ροή των υγρών μέσα στον οστίτη 
ιστό, κάτι που προσδίδει στο οστό γλοιοελαστικές ιδιότητες. Τα οστεοκύτταρα, 
πιστεύεται, ότι έχουν τη δυνατότητα να μεταφέρουν μηνύματα που έχουν σχέση με 
αλλαγές του μηχανικού περιβάλλοντος και των καταπονήσεων που δέχονται τα οστά 
και, κατά συνέπεια, συνεισφέρουν σημαντικά στη λειτουργία προσαρμογής των 
οστών στο μηχανικό τους περιβάλλον. 

Οι οστεοβλάστες είναι κυβοειδή κύτταρα με έκκεντρο πυρήνα, ανεπτυγμένο 
σύμπλοκο Golgi, και εκτεταμένο ενδοπλασματικό δίκτυο. Βρίσκονται πάνω στις 
ελεύθερες οστικές επιφάνειες και όταν διεγερθούν αλλάζουν σχήμα (στρογγυλό, 
ελλειψοειδές ή πολυεδρικό), σχηματίζουν νέα οστική οργανική θεμέλιο ουσία και 
ρυθμίζουν την αποτιτάνωση. Παρουσιάζουν κυτταροπλασματικές προσεκβολές που 
εκτείνονται διαμέσου της αποτιτανωμένης θεμελίου ουσίας, με σκοπό την 
επικοινωνία τους με τα οστεοκύτταρα. Κατά τη διάρκεια της μη διεγερτικής τους 
φάσης, είτε παίρνουν σχήμα επίπεδο σχηματίζοντας έτσι τα επενδυματικά κύτταρα 
των ελεύθερων οστικών επιφανειών, είτε αυτοπεριβάλλονται από αποτιτανωμένη 
θεμέλιο ουσία και μετατρέπονται σε οστεοκύτταρα. 

Οι οστεοκλάστες σχηματίζονται από συνένωση πολλαπλών μονοπύρηνων 
κυττάρων που προέρχονται από τον μυελό των οστών. Είναι μεγάλα κύτταρα 
ανώμαλου σχήματος, με πολλούς πυρήνες και το κυτταρόπλασμα τους, περιέχει 
πολλά μιτοχόνδρια, τα οποία δίνουν την απαραίτητη ενέργεια για την εκπλήρωση της 
βασικής λειτουργίας των οστεοκλαστών, την απορρόφηση οστού. Βρίσκονται στις 
εσωτερικές επιφάνειες του ενδόστεου, του περιόστεου και των συστημάτων του 
Havers και κάθονται πάνω στη θεμέλιο ουσία. Μόλις τελειώσουν την απορροφητική 
τους δραστηριότητα, έχουν τη δυνατότητα, είτε να μετακινηθούν σε παρακείμενη 
οστική επιφάνεια, είτε να διαιρεθούν σε πολλαπλά κύτταρα.  

Οι οστεοκλάστες έχουν τη δυνατότητα της αναδίπλωσης της 
κυτταροπλασματικής τους μεμβράνης προς την πλευρά της απορροφούμενης 
θεμελίου ουσίας. Αυτή η αναδίπλωση σχηματίζει ένα σύνθετο όξινο 
μικροπεριβάλλον, όπου υπάρχει μεγάλη συγκέντρωση ιόντων υδρογόνου και 
πρωτεολυτικά ένζυμα. Σε αυτό το περιβάλλον αφαιρούνται τα μεταλλικά ιόντα από 
τη θεμέλιο ουσία η οποία εν συνεχεία διαλύεται από τα ένζυμα. Στα σπογγώδη οστά 
οι οστεοκλάστες σχηματίζουν χαρακτηριστικές κοιλότητες, που ονομάζονται βοθρία 
του Howship (Howship lacunae), ενώ στα φλοιώδη σχηματίζουν τον κοπτικό κώνο 
(cutting cone) των συστημάτων του Havers. 
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Εικόνα 1.3: Σχηματική παράσταση από τομή τμήματος οστεώνα, όπου αναγνωρίζονται ο κεντρικός 
σωλήνας του Havers , τα ομόκεντρα πετάλια πεταλιώδους οστού και οι κοιλότητες Howship (οστικά 

βοθρία), όπου βρίσκονται τα οστεοκύτταρα[2]. 

 

Όσον αφορά στην οστική θεμέλιο ουσία, αποτελείται από οργανικά 
μακρομόρια (20% του συνολικού οστικού βάρους), ανόργανα άλατα (κατά 70%) και 
τα υγρά της θεμέλιας ουσίας (8-10%). Το 90% της οργανικής θεμελίου ουσίας 
αποτελείται από κολλαγόνο τύπου I, ενώ το υπόλοιπο 10% αποτελείται από μικρού 
μεγέθους πρωτεϊνογλυκάνες, άλλες μη κολλαγονούχες πρωτεΐνες (π.χ. οστεονεκτίνη) 
και μικρή ποσότητα κολλαγόνου τύπου V [1]. 

 

1.6 Οστική ανακατασκευή 

Μία πολύ σημαντική λειτουργία του οστίτη ιστού είναι η οστική 
ανακατασκευή, η οποία είναι υπεύθυνη για την προοδευτική αλλαγή της μορφής των 
οστών κατά την ανάπτυξη, για το ισοζύγιο ασβεστίου στο σώμα, καθώς και για τη 
διατήρηση, τη συντήρηση και την προσαρμογή των οστών στο μηχανικό ερέθισμα. Η 
οστική ανακατασκευή σαν κυτταρική λειτουργία, προβλέπει αρχικά ενεργοποίηση 
κυττάρων, απορρόφηση παλαιού ώριμου οστίτη ιστού από τις οστεοκλάστες, 
αναστροφή και τέλος παραγωγή ίσου ποσού νέου οστεοειδούς από οστεοβλάστες, 
που αργότερα αποτιτανώνεται. Με αυτόν τον τρόπο, το οστικό ισοζύγιο παραμένει 
σταθερό. 
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1.7 Αιμάτωση των οστών 

Στα οστά υπάρχει ένα πολύπλοκο σύστημα αγγείωσης. Όλα τα κύτταρα 
βρίσκονται σε απόσταση μικρότερη από 300 μm από τα οστικά αρτηρίδια. Τα μακρά 
αυλοειδή οστά, έχουν 3 πηγές αιμάτωσης. Αυτές είναι, η τροφοφόρος αρτηρία, οι 
επιφυσιακές και μεταφυσιακές διατιτραίνουσες αρτηρίες και οι αρτηρίες του 
περιοστέου. 

Η τροφοφόρος αρτηρία εισέρχεται διά του φλοιού στο μυελικό αυλό, 
χωρίζεται σε κεντρικό και περιφερικό κλάδο και σχηματίζει το μυελικό αρτηριακό 
δίκτυο που αιματώνει τη διάφυση. Αρτηρίδια από τους κλάδους της τροφοφόρου 
αναστομώνονται με αρτηρίδια των περιοστικών και μεταφυσιακών αρτηριών που 
διαπερνούν το φλοιό. Οι τελικοί κλάδοι αυτών των αναστομώσεων στο φλοιό, είναι 
το τριχοειδές αρτηρίδιο του οστεώνα (σύστημα Havers). Επιπλέον, ο φλοιός 
συνδέεται με το εσωτερικό του φλοιού με ένα κάθετο στην επιφάνεια του οστού 
δίκτυο σωληνίσκων, το δίκτυο σωλήνων του Volkmann (Volkmann’s canals), το 
οποίο επίσης επικοινωνεί με τα συστήματα του Havers. 

 

       

Εικ.1.4(α)                                                        Εικ. 1.4(β) 

Εικόνα 1.4: (α) Σύστημα του Havers ή οστεώνας (β) Κανάλι του Volkmann 

 

Κάτω από φυσιολογικές συνθήκες υπάρχει ροή αίματος, υγρών και ιόντων 
μέσα στα συστήματα αυτά των σωληνίσκων, που είναι υπεύθυνη για τα ηλεκτρικά 
φαινόμενα που αναπτύσσονται στα οστά. Η υγρή αυτή φάση των οστών είναι εν 
μέρει υπεύθυνη για τις ιδιαίτερες μηχανικές ιδιότητες των οστών. 
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Εικόνα 1.5: Σχηματική παράσταση αρτηριακής δομής οστού[4] 

 

 

 

1.8 Τύποι μηχανικής φόρτισης και καταπόνησης των 
οστών 

Κάτω από συνθήκες αυξημένων μηχανικών καταπονήσεων, τα οστά δέχονται 
την επίδραση δυνάμεων και ροπών. Η μηχανική συμπεριφορά των οστών εξαρτάται 
από την αντοχή τους, τα γεωμετρικά τους χαρακτηριστικά και από τον τύπο, την 
ταχύτητα και τη συχνότητα της φόρτισης. Οι δυνάμεις και οι ροπές επιδρούν πάνω 
στα οστά προς διάφορες κατευθύνσεις και προκαλούν τις φορτίσεις. Κάτω από την 
επίδραση των φορτίσεων, και με την προϋπόθεση ότι τα οστά βρίσκονται σε 
κατάσταση ισορροπίας, αναπτύσσονται εσωτερικέ παραμορφωτικές τάσεις. 

Κατά την επίδραση εφελκυστικών δυνάμεων σ’ ένα οστό αναπτύσσονται 
συμμετρικές εσωτερικές τάσεις και παραμορφώσεις. Οι μέγιστες τιμές τους 
παρουσιάζονται σε επίπεδο κάθετο προς αυτό της εφαρμογής των εφελκυστικών 
δυνάμεων. Υπό αυτές τις συνθήκες, τα οστά επιμηκύνονται και λεπτύνονται. 

Η εφαρμογή συμπιεστικών δυνάμεων σε οστό έχει επίσης σαν αποτέλεσμα 
την ανάπτυξη συμμετρικών εσωτερικών τάσεων και παραμορφώσεων. Οι μέγιστες 
τιμές τους παρουσιάζονται σε επίπεδο κάθετο στο επίπεδο της φόρτισης. Σε αυτήν 
την περίπτωση τα οστά βραχύνονται και διευρύνονται. 

Με την εφαρμογή διατμητικών δυνάμεων σε οστό αναπτύσσονται εσωτερικές 
διατμητικές τάσεις και παραμορφώσεις, με διεύθυνση που αρχικά σχηματίζει ορθή 
γωνία με την επιφάνεια του οστού, ενώ με τη συνέχιση της εφαρμογής των φορτίων η 
γωνία οξύνεται. 
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Η εφαρμογή καμπτικών δυνάμεων τα οστά υπόκεινται σε κάμψη γύρω από 
έναν άξονα. Κατά την κάμψη οστού, αυτό υφίσταται έναν συνδυασμό εφελκυστικών 
δυνάμεων από τη μία πλευρά του ουδέτερου άξονα και συμπιεστικών από την άλλη. 
Το μέγεθος των τάσεων και των παραμορφώσεων είναι ανάλογο της απόστασής τους 
από τον ουδέτερο άξονα. 

Τέλος, με την εφαρμογή στρεπτικών δυνάμεων σε οστό (μακρό), αυτό τείνει 
να περιστραφεί γύρω από έναν άξονα και στο εσωτερικό του αναπτύσσονται 
στροφικές ροπές. Επίσης αναπτύσσονται διατμητικές πιέσεις και παραμορφώσεις σε 
επίπεδα κάθετα και παράλληλα προς τον άξονα στρέψης, καθώς και συμπιεστικές και 
διατμητικές πιέσεις και παραμορφώσεις σε επίπεδα διαγώνια προς τον ίδιο άξονα. 
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ΚΕΦΑΛΑΙΟ 2ο 

 

 

ΑΝΑΤΟΜΙΑ ΑΚΡΟΥ ΠΟΔΟΣ 

 

 

 

 

Ανατομία ποδιού. Μετατάρσια. 

Κινησιολογία. 
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2.1 Εισαγωγή 

Σε αυτό το κεφάλαιο περιγράφεται η ανατομία του ποδιού. Γίνεται λόγος για 
τα οστά, τους αρθρικούς χόνδρους και τους συνδέσμους όσον αφορά στα συστατικά 
τους στοιχεία, και εξετάζεται η κινησιολογία των αρθρώσεων. Το μεγαλύτερο βάρος 
δίνεται στα οστά της μεταταρσικής περιοχής και τις φάλαγγες. 

 

2.2 Ανατομία άκρου ποδός 

Ο σκελετός του ποδιού αποτελείται συνολικά από 26 οστά, τα οποία 
διακρίνονται σε 3 ομάδες: τα οστά του ταρσού (tarsus), του μεταταρσίου (metatarsus) 
και των δακτύλων (phalanges). Τα οστά του μεταταρσίου και των δακτύλων 
ομαδοποιούνται και στη βιβλιογραφία συναντώνται ως πρόσθιο μέλος ποδός 
(forefoot). 

 

Εικόνα 2.1: Τα οστά του ποδιού 

Στα οστά του ταρσού περιλαμβάνονται ο αστράγαλος (talus), η πτέρνα 
(calcaneus), το σκαφοειδές (navicular), το κυβοειδές (cuboid) και τα 3 σκαφοειδή 
οστά (cuneiforms). Τα οστά του μεταταρσίου είναι 5 μακρά οστά που ονομάζονται 
μετατάρσια (metatarsals), ενώ καθένα από τα οστά των δακτύλων αποτελείται από 3 
επιμήκη οστά που καλούνται φάλαγγες, με εξαίρεση το μεγάλο δάκτυλο που 
αποτελείται από 2 οστά αντί για 3 [5]. 

Τα οστά του άκρου ποδός μέσω των αρθρικών τους επιφανειών συνδέονται 
στις αρθρώσεις. Οι αρθρώσεις επιτρέπουν τις κινήσεις των οστών μεταξύ τους και 
είναι σημαντικές για τη μεταβατική κίνηση από τη στήριξη στην πτέρνα, στη στήριξη 
των δακτύλων. Η κάθε αρθρική επιφάνεια, καλύπτεται από υαλοειδή χόνδρο, ο 
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οποίος διευκολύνει την ολίσθηση μεταξύ των οστών. Η άρθρωση περιβάλλεται από 
έναν ινώδη σάκο (αρθρικός θύλακος) και ελαστικούς ιστούς, τους συνδέσμους,  που 
συγκρατούν τα οστά σε ένα σταθερό άξονα. 

Ο υαλοειδής χόνδρος, αποτελείται κατά 30% από ινίδια κολλαγόνου (κυρίως 
τύπου I και δευτερευόντως τύπου V, VI, IX, X, XI) και πρωτεογλυκάνες, και κατά 
70% από νερό και ανόργανα άλατα. Είναι ιξωδοελαστικός λόγω του ότι είναι 
εύκαμπτος, πορώδης, με κενά γεμάτα νερό. 

Οι σύνδεσμοι είναι ινώδεις ελαστικοί ιστοί. Αποτελούνται κατά 55-65% από 
νερό και κατά 35-45% από κολλαγόνο, κυρίως τύπου I, ελαστίνη και 
πρωτεογλυκάνες. Η δομή του κολλαγόνου στους συνδέσμους, είναι απλή και 
φαίνεται σχηματικά στην εικόνα 2.2. Το τροποκολλαγόνο (δομική μονάδα 
κολλαγόνου), σχηματίζει μικροϊνίδια διαμέτρου 4nm, τα οποία στη συνέχεια 
σχηματίζουν υποϊνίδια διαμέτρου 20 nm, τα οποία σχηματίζουν ινίδια διαμέτρου 50-
500 nm, τα οποία τελικά σχηματίζουν ίνες κολλαγόνου με διάμετρο 100-300 μm. Το 
κολλαγόνο προσδίδει στους συνδέσμους εφελκυστικές ιδιότητες. 

 

Εικόνα 2.2: Σχηματική παράσταση της ιεραρχικής δομής του κολλαγόνου στο μεσοδιάστημα ενός 
συνδέσμου. 

 

Οι αρθρώσεις (joints) του άκρου ποδός φαίνονται στην εικόνα 2.3 και είναι: η 
ποδοκνημική (talocrural), η υπαστραγαλική (subtalar), η αστραγαλοσκαφοειδής 
(talonavicular), η πτερνοκυβοειδής (calcaneocuboid), η σκαφοσφηνοειδής 
(cuneonavicular), η σφηνοκυβοειδής (cuneocuboid), οι διασφηνοειδείς 
(intercuneiform), οι ταρσομετατάρσιες (tarsometatarsal), οι διαμετατάρσιες 
(intermetatarsal), οι μεταταρσοφαλαγγικές (metatarsophalangeal), οι εγγύς 
διαφαλαγγικές (proximal interphalangeal) και οι άπω διαφαλαγγικές (distal 
interphalangeal) [5].  
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 Εικόνα 2.2: Οι αρθρώσεις του ποδιού 

Τα μετατάρσια αποτελούν το βασικό αντικείμενο μελέτης της παρούσας 
Διπλωματικής εργασίας, γι’ αυτό και στη συνέχεια περιγράφονται διεξοδικά. 

 
 

2.3 Ανατομία μεταταρσίων 

Τα μετατάρσια είναι 5 και αριθμούνται από μέσα προς τα έξω. Έτσι, το 1ο 
μετατάρσιο αντιστοιχεί στο μεγάλο δάκτυλο και το 5ο στο μικρό. Είναι επιμήκη οστά 
και αποτελούνται από το σώμα και τα δύο άκρα (κεφαλή, βάση). Στο ένα τους άκρο, 
την βάση) αρθρώνονται με ορισμένα οστά του ταρσού (σφηνοειδή, κυβοειδές), ενώ 
το άλλο άκρο, η κεφαλή, αρθρώνεται με την 1η φάλαγγα του σύστοιχου δακτύλου 
(proximal phalange). 

Το σώμα τους, έχει πρισματοειδή μορφή και λεπτύνεται βαθμιαία από τον 
ταρσό προς το φάλαγγα, ενώ παράλληλα καμπυλώνεται εμφανίζοντας κοίλα στην 
πελματιαία πλευρά και κυρτά στη ραχιαία. Η βάση τους έχει σφηνοειδή μορφή και 
αρθρώνεται μετωπικά με τα οστά του ταρσού και πλευρικά με τα γειτνιάζοντα 
μετατάρσια. Τόσο η ραχιαία όσο και η πελματιαία επιφάνεια της βάσης, εμφανίζουν 
τραχύτητα, και αποτελούν τα σημεία πρόσφυσης των συνδέσμων. Η αρθρική 
επιφάνεια της κεφαλής τους είναι κοίλη και εκτείνεται περισσότερο από την κάτω 
πλευρά απ’ ότι από την πάνω. Οι πλευρικές τους επιφάνειες εμφανίζονται πιο 
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ομαλοποιημένες, και η καθεμία τους φέρει κόνδυλο, ο οποίος αποτελεί σημείο 
πρόσφυσης των συνδέσμων. Η πελματιαία τους επιφάνεια εμφανίζει αυλάκωση, από 
την οποία διέρχονται οι τένοντες. 

 

1ο Μετατάρσιο 

Το 1ο μετατάρσιο είναι το βραχύτερο και παχύτερο από όλα τα μετατάρσια. Το σώμα 
του είναι στιβαρό με πρισματοειδή μορφή. Κατά κανόνα δεν εμφανίζει αρθρικές 
επιφάνειες πλευρικά, παρά μόνο κατά περίπτωση, όπου στην εσωτερική πλευρά 
εμφανίζει μία ωοειδή επιφάνεια μέσω της οποίας αρθρώνεται με το 2ο μετατάρσιο. Η 
πρόσθια αρθρική επιφάνεια είναι νεφροειδής, μεγάλου μεγέθους και περιφερειακά 
εμφανίζει αυλακώσεις για τη διέλευση των συνδέσμων. Η κεφαλή είναι σχετικά 
μεγάλου μεγέθους και στην πελματιαία της επιφάνεια εμφανίζει 2 τραχείες, ελαφρώς 
ανυψωμένες, επιφάνειες πάνω στις οποίες ολισθαίνουν τα σησαμοειδή οστά 
(sesamoid bones, οστικές δομές που εμπεριέχονται μέσα σε τένοντα).  

 

Εικόνα 2.4: Σχηματική απεικόνιση 1ου μεταταρσίου 

 



 
21 

 

2ο Μετατάρσιο 

Το 2ο μετατάρσιο είναι το μεγαλύτερο σε μήκος από όλα τα μετατάρσια. Η βάση του 
είναι πλατιά επάνω, στενή και τραχεία κάτω, με 4 αρθρικές επιφάνειες: μία 
τριγωνικής μορφής για άρθρωση με το 2ο σφηνοειδές οστό, μία για άρθρωση με το 1ο 
σφηνοειδές οστό, και δύο στην εσωτερική πλευρά. Ανάμεσα στις δύο τελευταίες 
επιφάνειες, παρεμβάλλεται μία μη αρθρική τραχεία επιφάνεια, ενώ καθεμία από 
αυτές χωρίζεται σε δύο τμήματα, ένα μετωπικό κι ένα πλευρικό. Έτσι, οι δύο 
μετωπικές επιφάνειες αρθρώνονται με το 3ο σφηνοειδές οστό και οι δύο πλευρικές, με 
το 3ο μετατάρσιο. Μία πέμπτη επιφάνεια εμφανίζεται κατά περίπτωση, για άρθρωση 
με το 1ο μετατάρσιο, η οποία έχει σχήμα ωοειδές και βρίσκεται κοντά στη βάση. 

 

Εικόνα 2.5: Σχηματική απεικόνιση 2ου μεταταρσίου 
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3ο Μετατάρσιο 

Το 3ο μετατάρσιο μέσω μίας λείας τριγωνικής επιφάνειας με το 3ο σφηνοειδές, μέσω 
δύο ξεχωριστών επιφανειών με το 2ο μετατάρσιο και πλευρικά μέσω μίας αρθρικής 
επιφάνειας με το 4ο μετατάρσιο. 

 

 

Εικόνα 2.6: Σχηματική απεικόνιση 3ου μεταταρσίου 
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4ο Μετατάρσιο 

Το 4ο μετατάρσιο είναι μικρότερο σε μέγεθος από το 3ο. Στη βάση του εμφανίζεται 
μία, υπό κλίση, τετράπλευρη επιφάνεια για άρθρωση με το κυβοειδές οστό. 
Εσωτερικά υπάρχει μία λεία επιφάνεια το πρόσθιο τμήμα της οποίας αρθρώνεται με 
το 3ο μετατάρσιο, ενώ το οπίσθιο τμήμα της αρθρώνεται με το 3ο σφηνοειδές οστό. 
Πλευρικά, υπάρχει μία αρθρική επιφάνεια για άρθρωση με το 5ο μετατάρσιο. 

 

 

Εικόνα 2.7: Σχηματική απεικόνιση 4ου μεταταρσίου 
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5ο Μετατάρσιο 

Το 5ο μετατάρσιο φέρει ένα χαρακτηριστικό τραχύ εξόγκωμα (tuberosity) στην 
εξωτερική πλευρά της βάσης του. Η βάση αρθρώνεται μέσω μιας τριγωνικής 
επιφάνειας με το κυβοειδές οστό και εσωτερικά υπάρχει δεύτερη αρθρική επιφάνεια 
για άρθρωση με το 4ο μετατάρσιο [6]. 

 

 

Εικόνα 2.8: Σχηματική απεικόνιση 5ου μεταταρσίου 
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2.4 Κινησιολογία 

 

2.4.1 Κύκλος βαδίσματος 

Ένας πλήρης κύκλος βαδίσματος αρχίζει όταν το ένα πόδι έρθει σε επαφή με 
το έδαφος και ολοκληρώνεται όταν το ίδιο πόδι έρθει και πάλι σε επαφή με το 
έδαφος. Αποτελείται από τη φάση στήριξης (όταν το πόδι αγγίζει το έδαφος) και τη 
φάση αιώρησης (όταν το ίδιο πόδι δεν βρίσκεται σε επαφή με το έδαφος) 

Η φάση στήριξης καταλαμβάνει το 62% της διάρκειας του κύκλου, ενώ το 
υπόλοιπο 38% κατανέμεται στα στάδια της φάσης αιώρησης (Εικ. 2.9). Τα στάδια της 
φάσης στήριξης είναι πέντε: χτύπημα πτέρνας (heel strike), ισορροπία (foot flat), 
ανασήκωση πτέρνας (heel rise), ώθηση (push-off) και προώθηση (toe-off). Τα στάδια 
της φάσης αιώρησης είναι τρία: επιτάχυνση (acceleration), απομάκρυνση δακτύλων 
(toe clearance) και επιβράδυνση (deceleration). 

Εικόνα 2.9: Σχηματική παράσταση του κύκλου βαδίσματος 
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Το χρονικό διάστημα κατά το οποίο και τα δύο πόδια βρίσκονται σε επαφή με 
το έδαφος, λέγεται στήριξη σε δύο άκρα και καταλαμβάνει περίπου το 25% της 
συνολικής διάρκειας της φάσης στήριξης [7]. 

2.4.2 Κινηματικοί μηχανισμοί του ποδιού 

Ο όρος «μηχανισμός» αναφέρεται στη συνεργασία δύο ή και περισσότερων 
οστών και αρθρώσεων με σκοπό την κίνηση του ποδιού. Ένας μηχανισμός μπορεί να 
είναι από τη φύση του περιορισμένος ή μη περιορισμένος. Οι περιορισμοί οφείλονται 
στο σχήμα των αρθρικών επιφανειών και στο μήκος των συνδέσμων, καθώς και στα 
σημεία πρόσφυσης τους. Επίσης, είναι δυνατόν να επιβάλλονται περιορισμοί και 
λόγω του πλήθους των αρθρώσεων που απαρτίζουν τον μηχανισμό, όσον αφορά τη 
σχετική τους κίνηση. Ωστόσο, στους μη περιορισμένους μηχανισμούς, όπου δεν 
υπάρχουν περιορισμοί σαν αυτούς που προαναφέρθηκαν, απαιτούνται είτε μυϊκές είτε 
εξωτερικές δυνάμεις έτσι ώστε να καθορισθεί τελικά η κίνηση τους. 

Κατά την κίνηση του ποδιού, συνεργάζονται τρεις βασικοί μηχανισμοί: ο 
ταρσικός, που περιλαμβάνει τις αρθρώσεις μεταξύ των οστών του ταρσού, ο 
ταρσομετατάρσιος, που αποτελείται από τις ταρσομετατάρσιες αρθρώσεις και ο 
μεταταρσοφαλαγγικός, που απαρτίζεται από τις μεταταρσοφαλαγγικές αρθρώσεις. Ο 
πρώτος, χαρακτηρίζεται ως περιορισμένος μηχανισμός, ενώ οι άλλοι δύο ως μη 
περιορισμένοι. 

2.4.2.1  Ταρσομετατάρσιος μηχανισμός 

Τα μετατάρσια, σε αντίθεση με τα οστά του ταρσού, φαίνεται πως έχουν 
μεγαλύτερη ανεξαρτησία κινήσεων. Ένα βασικό ανατομικό χαρακτηριστικό, στο 
επίπεδο των ταρσομετατάρσιων αρθρώσεων, καθιστά τα μετατάρσια πιο κινητικά από 
τα οστά του ταρσού. Η βάση του 2ου μεταταρσίου είναι σταθερά προσαρμοσμένη στο 
κοίλωμα που σχηματίζουν τα σφηνοειδή οστά (Εικ. 2.3) και αυτό έχει σαν 
αποτέλεσμα τη δυνατότητα περιστροφής του πρόσθιου μέλους του ποδιού γύρω από 
τον επιμήκη άξονα του 2ου μεταταρσίου (supination and pronation twist). Αυτό το 
χαρακτηριστικό καθιστά τα μετατάρσια ικανά  να κινηθούν προς διαφορετικές 
κατευθύνσεις. 

2.4.2.2  Μεταταρσοφαλαγγικός μηχανισμός 

 Ο μεταταρσοφαλαγγικός μηχανισμός, χαρακτηρίζεται ως μη περιορισμένος 
μηχανισμός, και περιλαμβάνει τα μετατάρσια, τις φάλαγγες και τις πέντε 
μεταταρσοφαλαγγικές αρθρώσεις, οι οποίες είναι από τη φύση τους οι πιο κινητικές 
σε σχέση με τις υπόλοιπες αρθρώσεις του ποδιού. Χάρη στα διαφορετικά μήκη των 
πέντε μεταταρσίων, οι πέντε αυτές αρθρώσεις προσαρμόζονται σε έναν 
καμπυλόγραμμο σχηματισμό, που προσδίδει στο πόδι τη δυνατότητα να στρέφεται 
ασύμμετρα κατά το τρέξιμο ή το περπάτημα. 
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 Οι φάλαγγες του κάθε δακτύλου σχηματίζουν μεταξύ τους σταθερά τόξα, που 
αποτελούν τις πιο ακραίες κινηματικές αλυσίδες του ποδιού. Η ύπαρξή τους είναι 
υψίστης σημασίας για τη σωστή λειτουργία του μεταταρσοφαλαγγικού μηχανισμού. 
Οι μεταταρσοφαλαγγικές αρθρώσεις, μαζί με τις φαλαγγικές αλυσίδες, διαμορφώνουν 
5 ξεχωριστούς μηχανισμούς που χαρακτηρίζονται μη περιορισμένοι. 

2.4.3 Κινήσεις των δακτύλων 

 
2.4.3.1  Κίνηση του μέγα δακτύλου 

Η κίνηση του πρόσθιου μέλους του ποδιού καθορίζεται από την κίνηση της 
μεταταρσοφαλαγγικής άρθρωσης του πρώτου δακτύλου (hallux). Ο μέγας δάκτυλος, 
πρέπει να παρέχει ένα ευρύ φάσμα κινήσεων στο πόδι, έτσι ώστε αυτό να είναι ικανό 
να επιτελέσει διάφορες εργασίες. 

Η 1η μεταταρσοφαλαγγική άρθρωση έχει εύρος κινήσεων 120ο (κάμψη 30ο - 
έκταση 90ο), ενώ οι παράπλευροι σύνδεσμοι της άρθρωσης (διαμετατάρσιοι) είναι 
κατά κάποιον τρόπο χαλαροί και προσδίδουν στον μέγα δάκτυλο τη δυνατότητα της 
κίνησης, προς τα έσω και προς τα έξω. 

2.4.3.2  Κινήσεις των μικρών δακτύλων 

Τα τέσσερα μικρά δάκτυλα αποτελούνται, το καθένα, από τρεις φάλαγγες. Το 
δεύτερο δάκτυλο μπορεί να είναι κοντύτερο, μακρύτερο, ή να έχει ίδιο μήκος με τον 
μέγα δάκτυλο. 

Οι μεταταρσοφαλαγγικές αρθρώσεις των μικρών δακτύλων έχουν εύρος 
κινήσεων 140ο (κάμψη 50ο – έκταση 90ο), λίγο μεγαλύτερο, δηλαδή, από του μέγα 
δακτύλου [8]. 
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ΚΕΦΑΛΑΙΟ 3ο 

 

 

ΘΕΩΡΙΑ ΤΩΝ ΠΕΠΕΡΑΣΜΕΝΩΝ ΣΤΟΙΧΕΙΩΝ 

 

 

 

 

Μέθοδος Πεπερασμένων Στοιχείων. 

Μοντελοποίηση με χρήση εμπορικού λογισμικού. 
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3.1 Εισαγωγή 

Η αναλυτική λύση των εξισώσεων με τις οποίες περιγράφονται τα διάφορα 
τεχνικά προβλήματα είναι δυνατή μόνο σε ειδικές περιπτώσεις, όπου οι καταπονήσεις 
και τα γεωμετρικά σχήματα είναι πάρα πολύ απλά. Η ανάγκη επίλυσης πιο σύνθετων 
προβλημάτων οδήγησε στην ανάπτυξη διάφορων προσεγγιστικών μεθόδων. Μία 
τέτοια μέθοδος είναι και η Μέθοδος των Πεπερασμένων Στοιχείων. Το βασικό της 
πλεονέκτημα είναι ότι μπορεί να εφαρμοστεί σε όλα τα προβλήματα, ενώ το 
μειονέκτημά της είναι οι αυξημένες απαιτήσεις σε υπολογιστική ισχύ, ιδίως όταν 
εφαρμόζεται σε σύνθετα μοντέλα. Αυτό όμως το μειονέκτημα ξεπεράστηκε τα 
τελευταία χρόνια χάρη στη ραγδαία ανάπτυξη των υπολογιστών. Η επιτυχία αυτής 
της μεθόδου ήταν τόσο μεγάλη, που ακόμα και σήμερα χρησιμοποιείται στην έρευνα 
και στην βιομηχανία για τον υπολογισμό και τη μελέτη διάφορων κατασκευών. 

Το αρχαιότερο εν ζωή εμπορικό πρόγραμμα πεπερασμένων στοιχείων είναι το 
NASTRAN ενώ σήμερα διατίθεται πληθώρα προγραμμάτων ανάλυσης κατασκευών, 
όπως τα ABAQUS, ADINA,ALGOR, ANSYS, COSMOS/M, DYTRAN, MARC, 
NISA, LS-DYNA3D, LUSAS, MSC/NASTRAN, SOLVIA κ.α. 

3.2 Μέθοδος Πεπερασμένων Στοιχείων 

Η Μέθοδος των Πεπερασμένων Στοιχείων (Finite Element Method) είναι μία 
εξέλιξη των μητρωϊκών μεθόδων αριθμητικής επίλυσης διαφορικών εξισώσεων. Είναι 
μία αριθμητική μέθοδος, προσεγγιστικής επίλυσης προβλημάτων μίας συνεχούς 
δομής, αυθαίρετης γεωμετρίας, συνθηκών φόρτισης και οριακών συνθηκών. Βασικό 
χαρακτηριστικό της μεθόδου είναι η τμηματοποίηση ενός συνεχούς χώρου σε ένα 
σύνολο διακριτών υποχώρων. 

 Η ανάλυση με τη Μέθοδο των Πεπερασμένων Στοιχείων, επιτυγχάνεται με τη 
χρήση Η/Υ, όπου και επιλύονται συστήματα διαφορικών εξισώσεων, οι οποίες 
περιγράφουν τη συμπεριφορά της δομής. Πρώτο βήμα της ανάλυσης και μελέτης της 
δομής είναι η τμηματοποίηση της δομής σε πεπερασμένο αριθμό τμημάτων, δηλαδή 
σε πεπερασμένα στοιχεία. Η επιλογή του κατάλληλου στοιχείου και του πλήθους των 
στοιχείων, είναι η σημαντικότερη ενέργεια του μηχανικού σε αυτό το βήμα της 
ανάλυσης. Όσο μεγαλύτερο το πλήθος κόμβων και στοιχείων τόσο ακριβέστερη αλλά 
και δαπανηρή θα είναι η επίλυση. 

Η σύνδεση των στοιχείων μεταξύ τους, επιτυγχάνεται μέσω των κόμβων, οι 
οποίοι αποτελούν συγκεκριμένα σημεία της γεωμετρίας των στοιχείων. Το σύνολο 
των στοιχείων και των κόμβων αποτελεί το πλέγμα της δομής και η όλη διαδικασία 
της τμηματοποίησης, ονομάζεται πλεγματοποίηση. 

 Σε όλες τις κατασκευές, ο κάθε κόμβος να χαρακτηρίζεται από κάποιες 
δυνατές μετατοπίσεις, οι οποίες αποτελούν τους βαθμούς ελευθερίας του κόμβου. 
Κατά τη διδιάστατη ανάλυση μίας κατασκευής, κάθε κόμβος έχει τη δυνατότητα να 
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μετατοπίζεται κατά τους άξονες x, y ενώ στην περίπτωση μίας τρισδιάστατης 
κατασκευής, ο κάθε κόμβος δύναται να μετατοπιστεί κατά τους άξονες x, y, z. Έτσι, 
για παράδειγμα, στις τρισδιάστατες κατασκευές, κάθε κόμβος έχει τρείς βαθμούς 
ελευθερίας, στις διδιάστατες, δύο, και στα δικτυώματα έναν βαθμό ελευθερίας. Η 
γνώση του συνόλου των κόμβων και των βαθμών ελευθερίας του κάθε κόμβου, 
καθιστά δυνατό τον υπολογισμό του συνόλου των δυνατών μετατοπίσεων της 
κατασκευής και οποιοσδήποτε τρόπος στήριξης της κατασκευής, δεσμεύει κάποιους 
βαθμούς ελευθερίας. 

 Κάθε πεπερασμένο στοιχείο, διατηρεί τις ίδιες ελαστικές ιδιότητες με την 
αρχική δομή. Έτσι, εξετάζεται η ελαστική συμπεριφορά της δομής, κατά τμήμα, 
μέσω των στοιχείων, τα οποία έχουν πεπερασμένο μέγεθος και απλούστερη μορφή, 
άρα και περιγράφονται από απλούστερες συναρτήσεις. Γνωρίζοντας λοιπόν τις 
μετατοπίσεις των κόμβων, μπορούν να υπολογιστούν οι μετατοπίσεις κάθε σημείου 
του στοιχείου. Το επόμενο βήμα είναι ο υπολογισμός των παραμορφώσεων και μετά 
των τάσεων. Εάν n είναι το πλήθος των κόμβων και k ο αριθμός των βαθμών 
ελευθερίας κάθε κόμβου, με εφαρμογή των Ενεργειακών Θεωρημάτων (Αρχή 
Δυνατών Έργων), καταλήγουμε σε ένα σύστημα k×n εξισώσεων με k×n αγνώστους 
(άγνωστες μετατοπίσεις). 

3.3 Είδη ανάλυσης πεπερασμένων στοιχείων 

 Η πλέον αρχική επιλογή είναι ο καθορισμός του φυσικού φαινομένου το οποίο 
καλείται ο μελετητής να προσομοιώσει (π.χ. ελαστική ανάλυση, πρόβλημα 
δυναμικού). Έπειτα, ακολουθεί ο καθορισμός του προβλήματος σε στατικό (static 
analysis) ή δυναμικό πρόβλημα (dynamic analysis). Ένα στατικό πρόβλημα δεν είναι 
χρονικά εξαρτώμενο, σε αντίθεση με ένα δυναμικό πρόβλημα, το οποίο είναι χρονικά 
εξαρτώμενο. Μία άλλη κατάταξη αφορά στο εάν το πρόβλημα είναι γραμμικό (linear) 
ή μη γραμμικό (nonlinear). Γραμμικό καλείται το πρόβλημα στο οποίο αν 
διπλασιαστεί το μέγεθος των εξωτερικών δράσεων (π.χ. δυνάμεων), διπλασιάζεται 
και το μέγεθος του αποτελέσματος. Αντίθετα, μη γραμμικό καλείται το πρόβλημα το 
οποίο δεν περιγράφεται από την αναλογία που προαναφέρθηκε [9]. 

 Σε όλες τις παραπάνω περιπτώσεις η μητρωική διατύπωση του προβλήματος 
είναι της μορφής: 

ሾࡹሿሼ   ሺݐሻሽ ൅  ሾ࡯ሿሼ ሺݐሻሽ ൅ ሾࡷሿሼxሺݐሻሽ ൌ ሼࢌሺݐሻሽ                     (3.1) 

Τα πιο συνηθισμένα είδη στοιχείων είναι τα δικτυώματα (truss elements), 
δοκοί (beam elements), στοιχεία επίπεδης ένστασης (plane stress), στοιχεία επίπεδης 
παραμόρφωσης (plane strain), στοιχεία πλακών, στοιχεία κελυφών (shell) και γενικά 
τρισδιάστατα στοιχεία (solid elements). 
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3.4 Μοντελοποίηση με χρήση του προγράμματος    
ANSYS/LS-DYNA 

Η μεθοδολογία ανάλυσης μιας κατασκευής περιλαμβάνει τον ορισμό της 
γεωμετρίας, την επιλογή του τύπου των πεπερασμένων στοιχείων, τη δημιουργία του 
πλέγματος της δομής, τον ορισμό των φυσικών και μηχανικών ιδιοτήτων των υλικών 
της δομής, την επιβολή των οριακών συνθηκών, την επιλογή του τρόπου επίλυσης, 
την επίλυση και τέλος την ανάγνωση των αποτελεσμάτων. 

Το ANSYS/LS-DYNA, όπως και τα περισσότερα προγράμματα ανάλυσης, 
ολοκληρώνουν τις παραπάνω διεργασίες σε συνολικά τρεις φάσεις: 

I. Την προ-επεξεργασία (preprocessing), που ξεκινάει από τον ορισμό της 
γεωμετρίας και τερματίζεται στην επιλογή των οριακών συνθηκών 

II. Την επίλυση του μοντέλου (solution) 
III. Τη μετα-επεξεργασία (postprocessing), που περιλαμβάνει την ανάγνωση και 

τη γραφική αναπαράσταση των αποτελεσμάτων 

 

3.4.1 Προεπεξεργασία 

Κατά την προεπεξεργασία τα βήματα που ακολουθούνται είναι τα εξής: 

• Ορισμός της γεωμετρίας της δομής 
• Επιλογή του τύπου των πεπερασμένων στοιχείων στα οποία θα 

τμηματοποιηθεί η δομή 
• Ορισμός ιδιοτήτων των υλικών της δομής 
• Δημιουργία του πλέγματος της δομής 
• Επιβολή φορτίσεων και οριακών συνθηκών 

Ένας τρόπος για να ορίσουμε τη γεωμετρία είναι η κατασκευή του όγκου. 
Αυτό επιτυγχάνεται με τη δημιουργία, αρχικά, κρίσιμων σημείων ελέγχου 
(keypoints). Από τα σημεία αυτά δημιουργούνται γραμμές, από τις οποίες παράγονται 
επιφάνειες, οι οποίες τελικά οδηγούν στη δημιουργία όγκων. Έτσι, χτίζουμε βήμα-
βήμα τη γεωμετρία μέσα στο περιβάλλον του ANSYS/LS-DYNA. Ένας δεύτερος 
τρόπος ορισμού της γεωμετρίας, είναι η απ’ ευθείας κατασκευή όγκων ή επιφανειών, 
είτε από σημεία (χωρίς την παραγωγή γραμμών), είτε δίνοντας διαστάσεις στο 
Καρτεσιανό σύστημα συντεταγμένων. Η γεωμετρία δύναται επίσης να προσδιοριστεί 
στο περιβάλλον ενός σχεδιαστικού προγράμματος CAD και στη συνέχεια να εισαχθεί 
στο ANSYS/LS-DYNA με τη συμπίεση αρχείου IGES (Initial Graphics Exchange 
Specification). 

Η επιλογή του τύπου των πεπερασμένων στοιχείων εξαρτάται από την 
επίλυση που θα ακολουθηθεί. Κατά τη διαδικασία της προεπεξεργασίας, υπάρχει 
δυνατότητα επιλογής ενός στοιχείου και αλλαγής του στη συνέχεια, χωρίς αυτό να 
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έχει επιπτώσεις στα αποτελέσματα. Η επιλογή των κατάλληλων πεπερασμένων 
στοιχείων αποτελεί τη σημαντικότερη απόφαση που καλείται να πάρει κανείς κατα τη 
φάση της προεπεξεργασίας. 

Οι μηχανικές και φυσικές ιδιότητες των υλικών ορίζονται από το Κύριο 
Μενού του ANSYS/LS-DYNA, με την επιλογή Material Props. Οι ιδιότητες 
εξαρτώνται από τις ιδιαιτερότητες του κάθε υλικού αλλά και από το είδος της 
επίλυσης που θα οριστεί. 

Η δημιουργία του πλέγματος της δομής γίνεται με χρήση του εργαλείου Mesh 
Tool. Το εργαλείο αυτό, μας δίνει η δυνατότητα της απόδοσης των ιδιοτήτων σε 
ολόκληρη τη δομή ή σε τμήματα αυτής. Οι επιλογές που προσφέρονται, είναι η 
αυτόματη γένεση πλέγματος, ο ορισμός μεγέθους στοιχείων, καθώς και η επιλογή 
smart size, η οποία προσαρμόζει αυτόματα το πλέγμα στη γεωμετρία. Η χρήση του 
smart size συνιστάται για πλεγματοποίηση περιοχών απότομης αλλαγής γεωμετρίας 
και γενικά αποφεύγεται, καθώς πυκνώνει το πλέγμα και καθιστά την επίλυση 
χρονοβόρα. 

Τέλος, η επιβολή των οριακών συνθηκών αποτελεί την ενέργεια που 
ολοκληρώνει τον κύκλο της προεπεξεργασίας. Οι οριακές συνθήκες επιβάλλονται 
είτε σε γεωμετρικά στοιχεία (γραμμές, επιφάνειες, όγκους), είτε σε κόμβους του 
πλέγματος. 

3.4.2 Επίλυση 

Η επιλογή του τρόπου επίλυσης καθορίζεται από τη φύση του προβλήματος. 
Μπορεί δηλαδή να πρόκειται για πρόβλημα ελαστικής ανάλυσης ή πρόβλημα 
δυναμικού. Το πρόβλημα μπορεί να είναι γραμμικό ή μη γραμμικό, στατικό ή 
δυναμικό (§ 3.3). 

3.4.3 Μεταεπεξεργασία 

Μετά την επίλυση, και με την εκτέλεση της εντολής Read results, τα αποτελέσματα 
καταγράφονται σε ένα νέο αρχείο. Η ανάγνωση των αποτελεσμάτων μπορεί να γίνει 
με τη λήψη αποτελεσμάτων στους κόμβους (Nodal solution) ή στα στοιχεία (Element 
solution). Στην πρώτη περίπτωση δίνεται στους κόμβους η τιμή του μέσου όρου που 
προκύπτει από τα πεπερασμένα στοιχεία στα οποία είναι κοινός, ενώ στη δεύτερη 
δίνεται μία τιμή ανά πεπερασμένο στοιχείο. Η ανάγνωση, μπορεί επίσης να γίνει με 
την επιλογή Element Table, που αφορά στη διαδικασία ομαλοποίησης των 
αποτελεσμάτων υπολογίζοντας μέσους όρους [10]. 
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ΚΕΦΑΛΑΙΟ 4ο 

 

 

 ΕΠΕΞΕΡΓΑΣΙΑ ΑΞΟΝΙΚΩΝ ΤΟΜΟΓΡΑΦΙΩΝ ΚΑΙ 

ΠΑΡΑΓΩΓΗ ΤΡΙΣΔΙΑΣΤΑΤΗΣ ΓΕΩΜΕΤΡΙΑΣ 

 

 

 

 

Λήψη εικόνας από αξονικό τομογράφο.  

Επεξεργασία εικόνας. Βελτιστοποίηση γεωμετρίας. 
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4.1 Εισαγωγή 

 Η λήψη αλλά και η επεξεργασία των αξονικών τομογραφιών είναι ίσως το πιο 
σημαντικό κομμάτι της διαδικασίας μοντελοποίησης, καθώς σύμφωνα με αυτές θα 
γίνει η εξαγωγή της γεωμετρίας πάνω στην οποία θα γίνει προσομοίωση. 

Η διαδικασία που ακολουθείται για την απόκτηση της γεωμετρίας του μοντέλου, 
ξεκινάει από τη σάρωση, από τον αξονικό τομογράφο, του τμήματος του σώματος 
που μας ενδιαφέρει να αποτυπώσουμε. Οι τομογραφίες που λαμβάνονται, εισάγονται 
προς επεξεργασία στο πρόγραμμα Mimics, όπου και δημιουργείται η τρισδιάστατη 
γεωμετρία, η οποία με τη σειρά της, εισάγεται στο πρόγραμμα ANSYS. 

 

4.2 Λήψη εικόνας από αξονικό τομογράφο 

Οι αξονικές τομογραφίες προέρχονται από μία περίπλοκη μαθηματική 
διαδικασία, με χρήση μετασχηματισμού Fourier και είναι από τη φύση τους ψηφιακές 
εικόνες. Η προσωρινή αποθήκευσή τους γίνεται στον μαγνητικό δίσκο του αξονικού 
τομογράφου ενώ η μονιμότερη σε μαγνητο-οπτικούς δίσκους. Κάθε οπτικός δίσκος 
μιας συγκεκριμένης εταιρείας αξονικών τομογράφων (περίπου 10 στο σύνολο) είναι 
προσπελάσιμος μόνο από ειδικό οδηγό. Ωστόσο υπάρχουν κι άλλα μέσα δικτυακής 
επικοινωνίας και άλλων τρόπων αποθήκευσης. 

Σήμερα, για λόγους συμβατότητας, συνίσταται η χρήση του αρχείου τύπου 
DICOM. Τα αρχεία DICOM λαμβάνονται ευκολότερα όταν ο αξονικός τομογράφος 
διαθέτει μία δεύτερη κονσόλα, οπότε πολλές φορές είναι δυνατή η εξαγωγή ακόμη 
και σε άλλες εναλλακτικές μορφές, όπως TIFF και BITMAP. Οι σύγχρονοι αξονικοί 
τομογράφοι έχουν τη δυνατότητα να εξάγουν όλες τις προαναφερθείσες μορφές 
αρχείων ακόμη και σε ένα απλό CD ή και να τις μεταφέρουν μέσω Internet. 

Τα αρχεία DICOM δημιουργήθηκαν από την ανάγκη συμβατότητας των 
ψηφιακών εικόνων, που προέρχονταν από διαφορετικά μηχανήματα διαφορετικών 
κατασκευαστών. Στα πλαίσια λοιπόν της επεξεργασίας των ψηφιακών εικόνων σε μία 
κοινή βάση, έπρεπε να βρεθεί ένας τύπος αρχείων, που να είναι αποδεκτός από 
κοινού από όλους τους κατασκευαστές [11]. Έτσι προέκυψε το πρωτόκολλο DICOM 
(Digital Imaging and COmmunication in Medicine). Πρόκειται για ένα πρωτόκολλο 
διαχείρισης της ψηφιακής εικόνας, μια ομάδα κανόνων δηλαδή, που της δίνουν τη 
δυνατότητα μεταφοράς σε άλλο περιβάλλον, και διασφαλίζουν ότι τα δεδομένα 
αναγνώρισης και παραγωγής που συνοδεύουν την αρχική εικόνα, θα είναι 
αναγνωρίσιμα από όποιον τα χειρίζεται [12]. 
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4.3 Επεξεργασία εικόνας (Image Processing) 

Η επεξεργασία των δεδομένων του αξονικού τομογράφου έγινε με χρήση του 
εμπορικού λογισμικού Mimics (v. 10.01). Εργαζόμενοι στο Mimics έχουμε τη 
δυνατότητα να επεξεργαστούμε τα δεδομένα με σκοπό την απεικόνιση τρισδιάστατων 
αντικειμένων. 

Οι τομογραφίες που χρησιμοποιήθηκαν εξήχθησαν από αξονικό τομογράφο 
σε μορφή DICOM και υπό αυτήν τη μορφή εισήχθησαν στο Mimics. Η ψηφιακή 
ανάλυση της εικόνας είναι 512x512 pixels και το μέγεθος του κάθε pixel είναι 0,453 
mm. Οι τομές ελήφθησαν από τα τους άκρους πόδες 34χρονου άνδρα έχουν πάχος 1 
mm, ενώ στην ανακατασκευή το πάχος τομής ανέρχεται σε 0,750 mm. Όλες οι 
τομογραφίες έχουν τον ίδιο κατακόρυφο άξονα. 

Μετά την εισαγωγή των τομογραφιών στο Mimics ορίζεται η πρώτη και η 
τελευταία τομογραφία. Αυτό γίνεται, προς διευκόλυνση του χρήστη, για τον 
περιορισμό του πλήθους των προς επεξεργασία τομογραφιών. 

Το περιβάλλον εργασίας του Mimics φαίνεται στην εικόνα 4.1. Στη δεξιά 
πλευρά έχουμε τη δυνατότητα να δούμε τις εγκάρσιες τομογραφίες που σαρώθηκαν 
από τον αξονικό τομογράφο και με μετακίνηση της κυλιόμενης μπάρας (δεξιά της 
τομογραφίας) μπορούμε να μεταβούμε σε όποια τομογραφία επιθυμούμε. Στην 
αριστερή πλευρά, αυτό που παρατηρούμε δεν είναι τίποτε άλλο από τις τρισδιάστατες 
ανακατασκευασμένες εικόνες σε δύο επίπεδα, μετωπιαίο όσον αφορά στην πάνω 
εικόνα και οβελιαίο όσον αφορά στην κάτω. 

Κατά τη σάρωση οι ιστοί απορροφούν ακτινοβολία. Στην εικόνα 4.1 τα οστά 
φαίνονται καλύτερα, οι μαλακοί ιστοί αποτυπώνονται με σχεδόν γκρι χρώμα, ενώ με 
μαύρο αποτυπώνεται το κενό (ακτινοβολία που δεν απορροφήθηκε από τα οστά). 
Γενικά, όσο πιο συμπαγής είναι η δομή, τόσο πιο ευδιάκριτη γίνεται στην 
τομογραφία. 

Στις προς επεξεργασία τομογραφίες είναι δυνατόν να μην υπάρχουν μόνο τα 
οστά που πρόκειται να μοντελοποιηθούν, αλλά και άλλες δομές (χόνδροι, μαλακός 
ιστός) και αυτό γιατί ο τομογράφος σαρώνει μια ολόκληρη περιοχή. Γι’ αυτόν τον 
λόγο η μεθοδολογία επεξεργασίας των αξονικών τομογραφιών βασίζεται στη 
διαίρεση των απεικονιζόμενων δομών σε τμήματα (layers) που καλούνται μάσκες 
(masks). Προϋποθέτει την ξεχωριστή εργασία σε κάθε τμήμα, σε κάθε μάσκα  
δηλαδή, μέχρι την τελική απομόνωση των προς μοντελοποίηση οστών, στην 
περίπτωσή μας της μεταταρσικής περιοχής.  
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Εικόνα 4.1: Περιβάλλον εργασίας του Mimics 

Στο Mimics υπάρχει η δυνατότητα διακριτοποίησης των διαφορετικών δομών 
με εφαρμογή ορίων φωτεινότητας (thresholding). Με τη δυνατότητα αυτή ο χρήστης 
επιλέγει ένα κατώτερο κι ένα ανώτερο όριο φωτεινότητας έτσι ώστε να 
απεικονίζονται μόνο οι ιστοί που είναι εντός των ορίων αυτών (σκληροί ιστοί). Έτσι 
δημιουργείται μια μάσκα που περιλαμβάνει τα τμήματα που ανήκουν στα οστά του 
ποδιού (Εικ 4.2).  

 

Εικόνα 4.2: Γραφική απεικόνιση τμημάτων που ανήκουν στα οστά του αριστερού ποδιού 

Έπειτα, με την εντολή Region Growing έχουμε τη δυνατότητα να 
απομακρύνουμε γραφικά τα τμήματα που έχουν φωτεινότητα εντός των ορίων που 
επιλέχθηκαν, αλλά δεν ανήκουν στην υπό εξέταση μεταταρσική περιοχή. 
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Αφού απομονωθούν τα οστά της μεταταρσικής περιοχής, μαρκάρονται πάνω 
στις τομογραφίες οι περιοχές τους που δεν ανήκουν στα όρια φωτεινότητας που 
προκαθορίστηκαν κι έπειτα συμπληρώνονται (draw). Τα παραπάνω επιτυγχάνονται 
με τη λειτουργία Editing ενώ ο χρήστης μπορεί να εργάζεται ταυτόχρονα στις 
εγκάρσιες τομογραφίες και στις ανακατασκευασμένες εικόνες του μετωπιαίου και 
οβελιαίου επιπέδου.. 

 

Εικόνα 4.3: Δημιουργία ενιαίου όγκου στο περιβάλλον Mimics 

Με την ολοκλήρωση της επεξεργασίας, τα οστά της μεταταρσικής περιοχής, 
έχουν διαχωριστεί και έχουν αποκτήσει ενιαίο όγκο, τον οποίο μπορούμε να δούμε να 
δούμε με χρήση της εντολής Calculate 3D. Η τρισδιάστατη απεικόνιση των οστών 
αυτών, αμέσως θα εμφανιστεί, στη θέση κάτω από τις εγκάρσιες αξονικές 
τομογραφίες. Η γεωμετρία των οστών αναπαρίσταται με χρήση τριγωνικών 
στοιχείων. 

 

 

Εικόνα 4.4: Τρισδιάστατη απεικόνιση των οστών της μεταταρσικής περιοχής στο  Mimics 
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4.4 Βελτιστοποίηση γεωμετρίας 

Το πλέγμα της τρισδιάστατης γεωμετρίας αρχικά θα έχει τη μορφή της 
εικόνας 4.5. Για την καλύτερη επεξεργασία της γεωμετρίας όμως στο ANSYS, θα 
πρέπει να βελτιστοποιηθεί το πλέγμα των οστών, χωρίς αυτό να έχει επιπτώσεις στην 
υψηλής ποιότητας αναπαράστασή του. 

Με την εντολή Remesh οδηγούμαστε στο περιβάλλον επεξεργασίας του 
πλέγματος και βλέπουμε την τρισδιάστατη γεωμετρία της εικόνας 4.5. 

 

Εικόνα 4.5: Περιβάλλον εργασίας της εντολής Remesh 

Στη συνέχεια, ακολουθώντας τη μεθοδολογία βελτιστοποίησης  του 
πλέγματος, με την εντολή smoothing επιτυγχάνεται εξομάλυνση της γεωμετρίας, 
μειώνονται οι περιττές λεπτομέρειες και η γεωμετρία παίρνει τη μορφή της εικόνας 
4.6. 

 

Εικόνα 4.6: Τρισδιάστατη απεικόνιση βελτιωμένης γεωμετρίας 
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Έπειτα, ελαττώνουμε τον αριθμό των τριγώνων (Triangle reduction), 
βελτιώνουμε την ποιότητα των τριγώνων (Auto Remesh, Optimize based method) και 
ελαττώνουμε για δεύτερη φορά τον αριθμό των τριγώνων αλλά διατηρώντας την 
ποιότητα (Triangle reduction, Quality preserving). Τώρα η τελική γεωμετρία θα έχει 
τη μορφή της εικόνας 4.7. 

 

Εικόνα 4.7: Τρισδιάστατη απεικόνιση βέλτιστης γεωμετρίας 

 

Τελικά η τρισδιάστατη γεωμετρία που δημιουργήθηκε εξάγεται με τη μορφή 
Ansys Area Files (αρχείο με επέκταση .lis). Το αρχείο εισάγεται στο ANSYS με την 
εντολή Read Input from της επιλογής files (γραμμή εργαλείων του ANSYS). Κάθε 
τρίγωνο της γεωμετρίας που παρήχθη στο Mimics εισάγεται ως ξεχωριστή επιφάνεια 
στο ANSYS [13]. 
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ΚΕΦΑΛΑΙΟ 5ο 

 

 

 ΑΝΑΛΥΣΗ ΑΠΛΟΠΟΙΗΜΕΝΟΥ ΜΟΝΤΕΛΟΥ 
ΠΡΟΣΘΙΟΥ ΜΕΛΟΥΣ (FOREFOOT) ΑΡΙΣΤΕΡΟΥ ΠΟΔΙΟΥ 

 

 

 

 

Περιγραφή. Προεπεξεργασία.  

Ανάλυση τάσεων - παραμορφώσεων. 
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5.1 Περιγραφή μοντέλου 

Στο μοντέλο πεπερασμένων στοιχείων περιλαμβάνονται 22 οστά: τα 
μετατάρσια (πρώτο έως και πέμπτο), οι φάλαγγες (συνολικά 13), καθώς και τμήματα 
των σφηνοειδών (μέσου, ενδιάμεσου και πλάγιου) και του κυβοειδούς (Εικ. 5.1). 
Επιπλέον, περιλαμβάνονται και τα 2 σησαμοειδή οστά (Εικ.5.2), κοντά στην κεφαλή 
του 1ου μεταταρσίου και στην πελματιαία επιφάνεια. Σε αυτο το σημείο, πρέπει να 
σημειώσουμε ότι οι φάλαγγες κανονικά είναι 14 στο σύνολο, 3 σε κάθε δάκτυλο 
(εγγύς, μέση, περιφερική), με εξαίρεση το πρώτο δάκτυλο που έχει μονάχα 2. Απο το 
ακόλουθο μοντέλο, απουσιάζει η 2η περιφερική φάλαγγα, ενώ η 2η μέση δεν έχει την 
ακριβή της γεωμετρία και αυτό οφείλεται στις ψηφιακές εικόνες του αξονικού 
τομογράφου, οι οποίες εξ’ αρχής δεν ήταν ακριβείς και πλήρεις. 

 

 

 

Εικόνα 5.1: Οστά και περιοχές αρθρικού χόνδρου
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Εικόνα 5.2: Τα σησαμοειδή οστά 

Οι περιοχές αρθρικού χόνδρου διακρίνονται με κόκκινο χρώμα στην εικόνα 5.1. 
πρόκειται για τις ταρσομετατάρσιες, τις μεταταρσοφαλαγγικές και τις διαφαλαγγικές 
αρθρώσεις. 

Οι σύνδεσμοι που εμπλέκονται, διακρίνονται με κόκκινο χρώμα στην εικόνα 
5.3. Πρόκειται για τους άπω φαλαγγοφαλαγγικούς, τους εγγύς φαλαγγοφαλαγγικούς, 
τους μεταταρσοφαλαγγικούς, τους διαμεταταρσίους και τους συνδέσμους μεταξύ του 
ταρσού και των μεταταρσίων. 

 

Εικόνα 5.3: Σύνδεσμοι 

Στις μεταταρσοφαλαγγικές αρθρώσεις έχουν οριστεί επαφές επιφάνειας με 
επιφάνεια (contact surface-to-surface), από τις επιλογές LS-DYNA του ANSYS. Σε 
όλες τις υπόλοιπες αρθρώσεις, η αλληλεπίδραση μεταξύ των οστών έχει οριστεί με 
στοιχεία ανάλογων ιδιοτήτων με αυτές του αρθρικού χόνδρου. 
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5.2 Προεπεξεργασία μοντέλου 

Για τη δημιουργία και ανάλυση του μοντέλου των πεπερασμένων στοιχείων 
χρησιμοποιήθηκε το πακέτο ανάλυσης πεπερασμένων στοιχείων ANSYS, έκδοση 12, 
με προεπιλεγμένη την εφαρμογή LS-DYNA. 
 
5.2.1 Επιλογή υλικών 
 

Η επιλογή των υλικών αποτελεί το σημαντικότερο κομμάτι της 
μοντελοποίησης, ιδίως όσον αφορά σε βιολογικούς ιστούς, των οποίων οι ιδιότητες 
δεν είναι πλήρως καθορισμένες. Η μηχανική συμπεριφορά των βιολογικών ιστών 
είναι στις μέρες μας αντικείμενο έρευνας, ωστόσο στη βιβλιογραφία υπάρχει 
πληθώρα δεδομένων προς χρήση και αξιοποίηση. 
 
Οστά: 
 

Το οστό αποτελείται απο άλατα σε κρυσταλλική μορφή και από ίνες 
κολλαγόνου κι έτσι είναι από τη φύση του σύνθετο υλικό. Ενώ οι κρύσταλλοι 
οστικών αλάτων και οι ίνες κολλαγόνου έχουν εκ διαμέτρου αντίθετες ιδιότητες, ο 
συνδυασμός τους οδηγεί σε υλικό με πολύ μεγάλη αντοχή και σε θλίψη αλλά και σε 
εφελκυσμό. 

 
Για τα οστά που περιλαμβάνει το μοντέλο, ορίστηκαν γραμμικές, ελαστικές 

και ισοτροπικές ιδιότητες υλικού. Η τιμή του μέτρου ελαστικότητας του συμπαγούς 
οστού ορίστηκε ίση με 7300 MPa ενώ ο λόγος Poisson ίσος με 0,3 [14]. Για την 
επίλυση χρειάστηκε το μέγεθος της πυκνότητας του συμπαγούς οστού, η οποία 
υπολογίστηκε απο τη σχέση [15]: 
 

߃ ൌ 2065 ൈ  ଷ,଴ଽ                                             (5.1)ߩ
 

Η σχέση 5.1 αφορά σε φλοιώδες οστό, και η πυκνότητα προέκυψε ίση με 1,504 
gr/cm3. 
 
Αρθρικοί χόνδροι: 
 

Για όλους τους αρθρικούς χόνδρους, ορίστηκαν γραμμικές, ελαστικές και 
ισοτροπικές ιδιότητες υλικού. Η τιμή του μέτρου ελαστικότητας του αρθρικού 
χόνδρου ορίστηκε ίση με 1 MPa ενώ ο λόγος Poisson ίσος με 0,4 [16]. Καθώς δεν 
υπήρχε δυνατότητα υπολογισμού της πυκνότητας του αρθρικού χόνδρου, η τιμή της 
αναζητήθηκε βιβλιογραφικά και ορίστηκε ίση με 1,05 gr/cm3 [17]. 
 
Σύνδεσμοι: 
 

Για τους συνδέσμους ορίστηκαν ιδιότητες υλικού ανάλογες με αυτές ενός 
καλωδίου. Καμία δύναμη δεν αναπτύσσεται κατά τη θλίψη ενός συνδέσμου, ή όταν 
αυτός είναι σε ηρεμία. Δυνάμεις αναπτύσσονται όταν και μόνο όταν ο σύνδεσμος 
είναι σε έκταση. Η τιμή του μέτρου ελαστικότητας όλων των συνδέσμων, ορίστηκε 
ίση με 260 MPa και η πυκνότητά τους ίση με 1,15 gr/cm3. Η διατομή των συνδέσμων 
ορίστηκε ίση με 18,4 mm2. Οι ιδιότητες που αποδόθηκαν στους συνδέσμους, καθώς 
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και τα σημεία που έχουν επιλεγεί για την εφαρμογή τους, βασίζονται σε δεδομένα 
από τη βιβλιογραφία [18]. 

 
5.2.2 Τοποθέτηση πλέγματος 
 

Το μοντέλο αποτελείται συνολικά από 50954 στοιχεία. Για τη δημιουργία του 
3Δ πλέγματος των οστών και των αρθρικών επιφανειών χρησιμοποιήθηκαν 
τετραεδρικά δεκακομβικά στοιχεία (SOLID168). Το SOLID168 (Εικ.5.4) ορίζεται 
από 10 κόμβους, ο καθένας από τους οποίους έχει 3 μεταφορικούς βαθμούς 
ελευθερίας.  

 

 
Εικόνα 5.4: Το στοιχείο SOLID168 

 
 

Για την πλεγματοποίηση των συνδέσμων χρησιμοποιήθηκε το στοιχείο 
LINK167, που δέχεται μόνο αξονικά εφελκυστικά φορτία [10]. 
 
5.2.3 Συνθήκες φόρτισης 
 
5.2.3.1  Επιβολή φορτίων 
 

Κατά την ισορροπία της στατικής φάσης του βαδίσματος, το πόδι βρίσκεται 
σε ορθή στάση σε σχέση με το έδαφος. Αυτό πρακτικά σημαίνει ότι, αν το πόδι 
στηρίζεται σε μία οριζόντια πλάκα, ο άξονας του 1ου μεταταρσίου σχηματίζει γωνία 
30ο με το επίπεδο της πλάκας. Η φόρτιση που δέχεται το πόδι κατά τη στήριξη, είναι 
κάθετη στο επίπεδο της πλάκας και με φορά από το επίπεδο προς το πόδι. Άρα ο 
άξονας της φόρτισης και ο άξονας του 1ου μεταταρσίου σχηματίζουν γωνία 60ο [19] 
(Εικ. 5.5). 

 

 
Εικόνα 5.5: Επιβολή δύναμης στο 1ο μετατάρσιο 
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Το σωματικό βάρος του εθελοντή απο όπου προήλθε το μοντέλο είναι 82 kg. 
Για σωματικό βάρος 82 kg μία κάθετη δύναμη 402 N εφαρμόζεται σε κάθε πόδι κατά 
την ισορροπημένη ορθή στάση και η αντίδραση του εδάφους ισοκατανέμεται στην 
πτέρνα και στις κεφαλές των πέντε μεταταρσίων, δηλαδή 201Ν στην πτέρνα και 
201Ν στα μετατάρσια. Η φόρτιση του 1ου μεταταρσίου είναι διπλάσια από αυτήν των 
άλλων μεταταρσίων, άρα η συνολική φόρτιση στα πέντε μετατάρσια κατανέμεται ως 
εξής: 1/3 στο 1ο μετατάρσιο και από 1/6 στο 2ο,3ο, 4ο και 5ο [7]. 

 
Έτσι, η φόρτιση που επιβάλλεται σε κάθε μετατάρσιο κατα τη διάρκεια της 

ισορροπημένης φάσης είναι: 
1ο μετατάρσιο: 67 Ν 
2ο μετατάρσιο: 33,5 Ν 
3ο μετατάρσιο: 33,5 Ν 
4ο μετατάρσιο: 33,5 Ν 
5ο μετατάρσιο: 33,5 Ν 

 
5.2.3.2  Δυναμική επίλυση 
 

Κατά την ανάλυση δυναμικού προβλήματος, όλες οι δυνάμεις πρέπει να είναι 
χρονικά εξαρτημένες. Για τον λόγο αυτό η επιβολή των φορτίσεων στο ANSYS/LS-
DYNA γίνεται παραμετρικά με τη χρήση ζεύγους μητρώων, ένα που αναφέρεται στον 
χρόνο και έναν που αναφέρεται στη συνθήκη φόρτισης. 
 

Όλα τα φορτία επιβάλλονται σε ένα βήμα, σε αντίθεση με τη στατική 
ανάλυση όπου η επιβολή συνήθως απαιτεί περισσότερα βήματα. Επίσης, ορίζεται 
έναρξη της επιβολής φόρτισης (birth time) και παύση επιβολής φόρτισης (death 
time). 
 

Στο μοντέλο μας, οι δυνάμεις μεταβάλλονται απο 0 έως 67Ν στο 1ο 
μετατάρσιο και από 0 έως 33,5Ν στα υπόλοιπα τέσσερα μετατάρσια. Ο συνολικός 
χρόνος επιβολής της δύναμης ορίστηκε ίσος με 1 sec και η καμπύλη που περιγράφει 
τη μεταβολή της δύναμης σε σχέση με το χρόνο δίνεται από την εξίσωση: 
 

ሻݐሺܨ ൌ F ൈ ൤3 ൈ ቀ௧
்

ቁ
ଶ

െ 2 ൈ ቀ௧
்

ቁ
ଷ

൨                                  (5.2) 
 
όπου  Τ  είναι ο συνολικός χρόνος επιβολής της δύναμης (καμπύλη παρεμβολής κατά 
Hermite) [20]. 
 
 Από την σχέση 5.2 και για ߒ ൌ  υπολογίστηκαν οι τιμές της δύναμης για ܿ݁ݏ 1
ݐ ൌ ݐ ,0 ൌ ݐ ,0.2 ൌ ݐ ,0.4 ൌ ݐ ,0.6 ൌ 0.8 και ݐ ൌ  και δημιουργήθηκαν τα ܿ݁ݏ1
μητρώα του χρόνου και των φορτίσεων στα πέντε μετατάρσια. Έπειτα, επιλέχθηκαν 5 
κόμβοι, ένας στην πελματιαία επιφάνεια της κεφαλής κάθε μεταταρσίου, οι οποίοι 
αντιπροσωπεύουν τα σημεία εφαρμογής των δυνάμεων, και σε κάθε κόμβο 
επιβλήθηκε η δύναμη που του αντιστοιχεί. Τέλος, για την επιβολή της δύναμης, 
δημιουργήθηκε σύστημα αξόνων, σύμφωνα πάντα με όσα αναφέρθηκαν στην 
παράγραφο 5.2.3.1. 
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5.2.3.3  Οριακές συνθήκες 

 
Έγινε τυχαία επιλογή τεσσάρων από τους κόμβους που αντιστοιχούν στις 

πάνω επιφάνειες  των σφηνοειδών και του κυβοειδούς και ορίστηκε αυτοί να μη 
μετατοπίζονται προς καμία κατεύθυνση (Εικ. 5.6(α)). Επίσης, έγινε επιλογή πέντε 
κόμβων (ένας στο άκρο κάθε περιφερικής φάλαγγας) και ορίστηκε μηδενική 
μετατόπιση κατά μία διεύθυνση (uz) (Εικ. 5.6(β)). 

 
 

 

         
Εικ. 5.6(α)                                                           Εικ 5.6(β) 

 
Εικόνα 5.6: Οριακές συνθήκες (α) στον ταρσό και (β) στις φάλαγγες 

 
 
Η επιλογή των οριακών συνθηκών έγινε με το σκεπτικό της αποφυγής 

ανεπιθύμητων στροφών του μοντέλου κατα την εφαρμογή των δυνάμεων. 
 
 
5.2.4 Σύνοψη 
 
 Στον παρακάτω πίνακα παρουσιάζονται συνοπτικά οι ιδιότητες των υλικών 
και τα στοιχεία που έχουν επιλεγεί για την ανάλυση του μοντέλου. 
 
 
 
Συστατικό Στοιχείο Τύπος 

στοιχείου 
Μέτρο 

ελαστικότητας 
Ex (MPa) 

Λόγος 
Poisson 

ν 

Πυκνότητα 
ρ (gr/cm3) 

Εμβαδόν 
διατομής 

(mm2) 
Οστά SOLID168 Τετραεδρικό, 

δεκακομβικό 
7300 0.3 1.504 - 

Χόνδρος SOLID168 Τετραεδρικό, 
δεκακομβικό 

1 0.4 1.05 - 

Σύνδεσμοι LINK167 Μονοαξονικό 260 - 1.15 18.4 
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Στον παρακάτω πίνακα παρουσιάζονται οι τιμές της μέγιστης Von Mises 

ισοδύναμης παραμόρφωση για καθεμία από τις πέντε εγγύς φάλαγγες. 
 
 
 

 Μέγιστη Von Mises 
ισοδύναμη παραμόρφωση (mstrain) 

1η εγγύς φάλαγγα 1,203 
2η εγγύς φάλαγγα 2,307 
3η εγγύς φάλαγγα 3,480 
4η εγγύς φάλαγγα 3,010 
5η εγγύς φάλαγγα 2,537 

 
 
5.3.3 Λοιπά οστά του μοντέλου 
 

Οι μέγιστες τάσεις και παραμορφώσεις των λοιπών οστών που 
περιλαμβάνονται στο μοντέλο παρουσιάζονται στους παρακάτω πίνακες. 
 
 

 Μέγιστη Von Mises 
ισοδύναμη τάση (MPa) 

1η περιφερική φάλαγγα 12,805 
3η περιφερική φάλαγγα 10,000 
4η περιφερική φάλαγγα 13,269 
5η περιφερική φάλαγγα 19,734 

2η μέση φάλαγγα 27,538 
3η μέση φάλαγγα 14,373 
4η μέση φάλαγγα 15,130 
5η μέση φάλαγγα 29,357 

 
 Μέγιστη Von Mises 

ισοδύναμη παραμόρφωση (mstrain) 
1η περιφερική φάλαγγα 2,280 
3η περιφερική φάλαγγα 1,781 
4η περιφερική φάλαγγα 2,367 
5η περιφερική φάλαγγα 3,514 

2η μέση φάλαγγα 4,891 
3η μέση φάλαγγα 2,566 
4η μέση φάλαγγα 2,683 
5η μέση φάλαγγα 5,152 

 
 
Οι μέγιστες τάσεις και παραμορφώσεις που υπολογίστηκαν, είναι εξαιρετικά 

μεγάλες και αυτό οφείλεται στις οριακές συνθήκες, τις οποίες όμως δεν μπορούμε να 
αγνοήσουμε εάν θέλουμε να οδηγηθούμε σε επίλυση του μοντέλου. Στην παρούσα 
διπλωματική εργασία, τα συγκεκριμένα οστά δεν αποτελούν πρωτεύον αντικείμενο 
μελέτης, γι’ αυτο και οι συγκεκριμένες τιμές θα αγνοηθούν. 
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ΚΕΦΑΛΑΙΟ 6ο 

 

 

ΓΕΝΙΚΑ ΠΕΡΙ ΚΑΤΑΓΜΑΤΩΝ 

 

 

 

 

Εισαγωγή. Ανακατασκευή οστού. 

Τύποι καταγμάτων στο 5ο μετατάρσιο. 
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6.1 Εισαγωγή 

Με το όρο «κάταγμα» εννοούμε τη μερική ή ολική ασυνέχεια δομής ενός 
οστού. Κατάγματα και σπασίματα στα οστά, μπορούν να συμβούν είτε με την 
εφαρμογή ενός φορτίου που υπερβαίνει την αντοχή του οστού, είτε με την εφαρμογή 
μικρότερων επαναλαμβανόμενων φορτίων. Η δομική απώλεια μετά από 
επαναλαμβανόμενη φόρτιση είναι χαρακτηριστικό του οστίτη ιστού, και αναφέρεται 
σαν κόπωση υλικού. Το φαινόμενο της κόπωσης εμφανίζεται γρηγορότερα όταν το 
υλικό φορτίζεται στα όρια της ελαστικής του παραμόρφωσης. Στον οστίτη ιστό, με 
την επίδραση αυτών των φορτίων προκαλείται κυτταρική νέκρωση, μικροκάκωση και 
άθροιση μικροκαταγμάτων. Στα οστά το φαινόμενο της κόπωσης δεν εξαρτάται μόνο 
από το μέγεθος του φορτίου και τον αριθμό των επαναλήψεων, αλλά και από τη 
συχνότητα των φορτίσεων. Αυτό εξηγείται με τη λειτουργία της οστικής 
ανακατασκευής. 

 

6.2 Ανακατασκευή οστού 

Μια σημαντική ικανότητα που έχουν τα οστά, από τη στιγμή της δημιουργίας 
ενός κατάγματος και έπειτα, είναι αυτή της αυτοεπιδιόρθωσης. Μόλις το οστό 
υποστεί κάποιο κάταγμα αρχίζει η διαδικασία της αναγέννησης της δομής στην 
περιοχή του κατάγματος, που περιλαμβάνει μία πολυσύνθετη ακολουθία διεργασιών. 

 Η διαδικασία της πώρωσης, ξεκινάει με μία φλεγμονώδη αντίδραση στην 
περιοχή του κατάγματος και συνεχίζεται με τη δημιουργία ινώδους συνδετικού ιστού, 
έπειτα χόνδρου, έπειτα πορώδους οστού και ολοκληρώνεται με την απορρόφηση του 
οστέινου πώρου και την ανακατασκευή του οστού, σκοπός της οποίας είναι η 
αποκατάσταση της αρχικής δομής του οστού, με ότι αυτό μπορεί να συνεπάγεται (π.χ. 
μηχανικές ιδιότητες). Οι ενδιάμεσοι ιστοί που δημιουργούνται κατά τη πώρωση 
εξυπηρετούν στη σταθεροποίηση του μηχανικού περιβάλλοντος και παρέχουν έναν 
σκελετό πάνω στον οποίο «χτίζεται» ο νέος ιστός. 

Η διαδικασία της ανακατασκευής είναι άμεσα εξαρτημένη από τη μηχανική 
φόρτιση και από τη γεωμετρική διαμόρφωση της καταγματικής περιοχής [22]. 

 

6.3 Μαθηματική πρόβλεψη της οστικής ανακατασκευής 

Έχουν αναπτυχθεί αρκετές θεωρίες γύρω από τους μηχανισμούς που 
διεγείρουν το οστό και το προκαλούν να αντιδράσει, όταν αυτό βρίσκεται σε μία 
κατάσταση τροπής. Ωστόσο, είναι κοινώς αποδεκτό ότι το οστό αντιδρά σε μία 
πιθανή αλλαγή της εντατικής η της παραμορφωσιακής του κατάστασης, κατά τέτοιο 
τρόπο ώστε να αλλάξει τη μορφή του, και ότι η τροπή αποτελεί την κύρια αιτία 
διέγερσης του μηχανισμού ανακατασκευής.  
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Η σχέση μεταξύ της τάσης ή της παραμόρφωσης με το ρυθμό ανακατασκευής, 
μέχρι στιγμής δεν έχει καθοριστεί. Δεν υπάρχει δηλαδή κάποια μαθηματική σχέση 
που να περιγράφει το πως καθορίζει η τάση ή η παραμόρφωση την αντίδραση του 
οστού στην κατάσταση τροπής. Υπάρχουν όμως μερικές ιδέες που έχουν προταθεί για 
μακρά οστά και κάποιες από αυτές είναι [1]: 

• Κυμαινόμενα φορτία προκαλούν μεγαλύτερη ανακατασκευή από στατικά 
φορτία, αλλά αυτή περιορίζεται μέσα σε ένα εύρος συχνότητας 

• Αυξανομένης της τάσης, αυξάνεται και η απόθεση οστού 
• Οι καμπτικές ροπές προκαλούν μικρότερη ανακατασκευή απο αυτήν που 

προκαλούν τα θλιπτικά φορτία 
• Ανακατασκευή λαμβάνει χώρα έτσι ώστε να περιορίζεται η κατάσταση 

τροπής στην επιφάνεια του οστού 
• Στατικά φορτία δεν προκαλούν την ανακατασκευή των μακρών οστών 
• Η ανακατασκευή δεν λαμβάνει χώρα κάτω από μία συγκεκριμένη ελάχιστη 

τροπή, η οποία ονομάζεται ελάχιστη δρώσα τροπή και η τιμή της κυμαίνεται 
γύρω από το 0.002 

 

6.4 Συνήθη κατάγματα στο 5ο μετατάρσιο 

Κατάγματα μπορούν να προκληθούν στο 5ο μετατάρσιο είτε με την εφαρμογή 
ενός φορτίου που υπερβαίνει την αντοχή του, είτε με την εφαρμογή μικρότερων 
επαναλαμβανόμενων φορτίων. Τα κατάγματα 5ου μεταταρσίου, στη συντριπτική τους 
πλειοψηφία εμφανίζονται σε αθλητές [23]. 

Υπάρχουν διάφοροί τύποι καταγμάτων, οι συνηθέστεροι από τους οποίους 
είναι [24]: 

I. Κάταγμα με απόσπαση οστού στο κοίλο μόρφωμα της βάσης του 5ου 
μεταταρσίου (tuberosity) 

II. Κάταγμα Jones 
III. Κάταγμα στο σώμα του 5ου μεταταρσίου (mid-shaft fracture) 
IV. Κάταγμα λόγω πίεσης (stress fracture) 

Ο πρώτος τύπος κατάγματος, εμφανίζεται στο κοίλο μόρφωμα, στη βάση του 
5ου μεταταρσίου, και περιγράφεται από την απομάκρυνση του κομματιού αυτού από 
το οστό (Εικ. 6.1). Τέτοιου είδους κατάγματα είναι κοινά, εύκολα στη διάγνωση, 
αλλά και στην αντιμετώπισή τους. Δύο διαφορετικά είδη κατάγματος εντοπίζονται σε 
εκείνη την περιοχή: ένα αυτό που προαναφέρθηκε και ένα κοντά στη βάση του 
μεταταρσίου και σε απόσταση περίπου 1.5 cm από το κοίλο μόρφωμα (κάταγμα 
Jones) [29]. Κατά τη συστροφή του ποδιού, και για την αποφυγή τραυματισμού, 
επιστρατεύονται οι περονικοί μύες, οι τένοντες των οποίων προσφύονται σε αυτήν τη 
μικρή και ιδιαίτερη περιοχή και έτσι προκαλείται το κάταγμα [25]. 
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Εικόνα 6.1: Συνήθη κατάγματα του 5ου μεταταρσίου 

 Το κάταγμα Jones, είναι ένα εγκάρσιο κάταγμα που εμφανίζεται στα όρια της 
διάφυσης και της μετάφυσης του 5ου μεταταρσίου (Εικ. 6.1). Σε εκείνην την περιοχή, 
η αιμάτωση του οστού είναι περιορισμένη γι’ αυτό και η επούλωση είναι δύσκολη. 
Αυτό το ανατομικό χαρακτηριστικό, καθιστά το κάταγμα αυτού του τύπου 
σοβαρότερο από τα υπόλοιπα. Το κάταγμα Jones μπορεί να προκληθεί είτε ακαριαία, 
είτε με την εφαρμογή μικρών επαναλαμβανόμενων φορτίων [26]. 

 Ένα κάταγμα στο σώμα του 5ου μεταταρσίου, μπορεί να προκληθεί κατά τη 
στρέψη του άξονά του και μπορεί είναι είτε εγκάρσιο είτε λοξό, ενώ κάταγμα στην 
κεφαλή ή κοντά στην κεφαλή, μπορεί να προκληθεί όταν η στήριξη του ποδιού 
μεταφερθεί εξ’ ολοκλήρου στην περιοχή του 5ου μεταταρσίου. 

 Το κάταγμα πίεσης είναι ένα είδος σπασίματος (διακοπή συνέχειας της δομής) 
που εμφανίζεται στα μακρά οστά. Προκαλείται απο επαναλαμβανόμενη ή από συνεχή 
φόρτιση. Μπορεί να περιγραφεί από ένα μικρό ράγισμα του οστού το οποίο στην 
απαρχή του αμυδρά διακρίνεται. Γι’ αυτό και πολλές φορές αποκαλείται τριχοειδές 
κάταγμα (hairline fracture) [27]. 
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Εγκάρσιο, είναι το κάταγμα στο οποίο η φορά του επιπέδου του κατάγματος 
είναι παράλληλη με τον επιμήκη άξονα του οστού, ενώ λοξό λέγεται το κάταγμα στο 
οποίο η φορά του επιπέδου του κατάγματος σχηματίζει γωνία με αυτόν. 

Η διαδικασία της πώρωσης περιλαμβάνει τρία στάδια δημιουργίας ιστού στην 
καταγματική περιοχή. Η καταγματική περιοχή καλύπτεται κατά το πρώτο στάδιο από 
ινώδη ιστό (fibrous tissue), κατά το δεύτερο στάδιο από πρώιμο οστό (immature 
bone) και κατά το τρίτο στάδιο από ώριμο οστό (mature bone). 

 

7.3 Προεπεξεργασία μοντέλων 

Για τη δημιουργία και ανάλυση των μοντέλων των πεπερασμένων στοιχείων 
χρησιμοποιήθηκε το πακέτο ανάλυσης πεπερασμένων στοιχείων ANSYS, έκδοση 12, 
με προεπιλεγμένη την εφαρμογή LS-DYNA. 

Το 3Δ πλέγμα των μοντέλων δημιουργήθηκε σύμφωνα με τα όσα 
αναφέρθηκαν στο Κεφάλαιο 5 (§ 5.2.2). Οι συνθήκες φόρτισης και οι οριακές 
συνθήκες , διατηρήθηκαν ακριβώς όπως περιγράφονται στο Κεφάλαιο 5 (§ 5.2.3). 

Για τα οστά, τους αρθρικούς χόνδρους και τους συνδέσμους, ορίστηκαν 
ιδιότητες αντίστοιχες με αυτές που αναφέρονται στο Κεφάλαιο 5 (§ 5.2.1), ενώ στις 
καταγματικές επιφάνειες αποδόθηκαν ιδιότητες υλικού ανάλογα με το στάδιο 
πώρωσης του κατάγματος. 

 

1ο στάδιο - Ινώδης ιστός (Fibrous tissue): 

Για τον ινώδη ιστό ορίστηκαν γραμμικές, ελαστικές και ισοτροπικές ιδιότητες 
υλικού. Η τιμή του μέτρου ελαστικότητας ορίστηκε ίση με 2 MPa ενώ ο λόγος 
Poisson ίσος με 0,167. Για την επίλυση χρειάστηκε το μέγεθος της πυκνότητας του 
συμπαγούς οστού, η οποία υπολογίστηκε απο τη σχέση [15]: 
 

߃ ൌ 1904 ൈ  ଵ,଺ସ                                              (7.1)ߩ
 

Η σχέση 7.1 αφορά σε δοκιδώδες οστό, και η πυκνότητα προέκυψε ίση με 0,015 
gr/cm3. 
 
 
2ο στάδιο – Πρώιμο οστό (Immature bone): 

Για τον ανώριμο οστίτη ιστό ορίστηκαν γραμμικές, ελαστικές και ισοτροπικές 
ιδιότητες υλικού. Η τιμή του μέτρου ελαστικότητας ορίστηκε ίση με 1000 MPa ενώ ο 
λόγος Poisson ίσος με 0,3. Για την επίλυση χρειάστηκε το μέγεθος της πυκνότητας 
του συμπαγούς οστού, η οποία υπολογίστηκε απο τη σχέση 7.1, και προέκυψε ίση με 
0,675 gr/cm3. 
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3ο στάδιο – Ώριμο οστό (Mature bone): 

Για τον ώριμο οστίτη ιστό ορίστηκαν γραμμικές, ελαστικές και ισοτροπικές 
ιδιότητες υλικού. Η τιμή του μέτρου ελαστικότητας ορίστηκε ίση με 6000 MPa ενώ ο 
λόγος Poisson ίσος με 0,3. Για την επίλυση χρειάστηκε το μέγεθος της πυκνότητας 
του συμπαγούς οστού, η οποία υπολογίστηκε απο τη σχέση: 
 

߃ ൌ 2065 ൈ  ଷ,଴ଽ                                              (7.2)ߩ
 

Η σχέση 7.2 αφορά σε φλοιώδες οστό, και η πυκνότητα προέκυψε ίση με 1,412 
gr/cm3. 
 

Στον παρακάτω πίνακα συνοψίζονται οι τιμές των ιδιοτήτων υλικού των 
καταγματικών επιφανειών, για τα τρία στάδια της πώρωσης κατάγματος [28]. 

 

Στάδια Μέτρο ελαστικότητας Ex 
(MPa) 

Λόγος Poisson ν Πυκνότητα ρ 
(gr/cm3) 

1ο στάδιο 2 0.167 0.015 

2ο στάδιο 1000 0.3 0.675 

3ο στάδιο 6000 0.3 1.412 

 

Πίνακας 1: Σύνοψη τιμών ιδιοτήτων υλικού για καθένα από τα τρία στάδια της πώρωσης κατάγματος. 
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Διάγραμμα 7.1: Μεταβολή μέγιστης Von Mises τάσης σε τρία στάδια πώρωσης 

 

Διάγραμμα 7.2: Μεταβολή μέγιστης Von Mises παραμόρφωσης σε τρία στάδια πώρωσης 

 

 Από τα παραπάνω διαγράμματα προκύπτουν τα εξής συμπεράσματα όσον 
αφορά στο κάταγμα Κ1: 

• Η μέγιστη Von Mises τάση στις καταγματικές επιφάνειες εμφανίζεται κατά το 
3ο στάδιο 

• Η μέγιστη Von Mises τάση στις καταγματικές επιφάνειες αυξάνεται σταδιακά 
κατά τη μετάβαση από το 1ο στο 3ο στάδιο 

• Κατά τη μετάβαση από το πρώτο στάδιο στο δεύτερο, η μέγιστη τάση 
εμφανίζεται κατά 140 φορές μεγαλύτερη, ενώ κατά τη μετάβαση από το 
δεύτερο στάδιο στο τρίτο, παρουσιάζει αύξηση 46.6% 

• Η μέγιστη Von Mises παραμόρφωση στις καταγματικές επιφάνειες λαμβάνει 
χώρα κατα το 1ο στάδιο 

• Η μέγιστη Von Mises παραμόρφωση στις καταγματικές επιφάνειες μειώνεται 
σταδιακά κατά τη μετάβαση από το 1ο στο 3ο στάδιο 
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Διάγραμμα 7.3: Μεταβολή μέγιστης Von Mises τάσης σε τρία στάδια πώρωσης 

 

Διάγραμμα 7.4: Μεταβολή μέγιστης Von Mises παραμόρφωσης σε τρία στάδια πώρωσης 

 

Από τα παραπάνω διαγράμματα προκύπτουν τα εξής συμπεράσματα όσον αφορά στο 
κάταγμα Κ2: 

• Η μέγιστη Von Mises τάση στις καταγματικές επιφάνειες εμφανίζεται κατά το 
3ο στάδιο 

• Η μέγιστη Von Mises τάση στις καταγματικές επιφάνειες αυξάνεται σταδιακά 
κατά τη μετάβαση από το 1ο στο 3ο στάδιο 

• Κατά τη μετάβαση από το πρώτο στάδιο στο δεύτερο, η μέγιστη τάση είναι 
περίπου 90πλάσια της αρχικής, ενώ κατά τη μετάβαση από το δεύτερο στάδιο 
στο τρίτο, παρουσιάζει αύξηση που ανέρχεται στο 104% 

• Η μέγιστη Von Mises παραμόρφωση στις καταγματικές επιφάνειες λαμβάνει 
χώρα κατα το 1ο στάδιο 

• Η μέγιστη Von Mises παραμόρφωση στις καταγματικές επιφάνειες μειώνεται 
σταδιακά κατά τη μετάβαση από το 1ο στο 3ο στάδιο 
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Διάγραμμα 7.5: Μεταβολή μέγιστης Von Mises τάσης σε τρία στάδια πώρωσης 

 

Διάγραμμα 7.6: Μεταβολή μέγιστης Von Mises παραμόρφωσης σε τρία στάδια πώρωσης 

 

 Από τα παραπάνω διαγράμματα προκύπτουν τα εξής συμπεράσματα όσον 
αφορά στο κάταγμα Κ3: 

• Η μέγιστη Von Mises τάση στις καταγματικές επιφάνειες εμφανίζεται κατά το 
3ο στάδιο 

• Η μέγιστη Von Mises τάση στις καταγματικές επιφάνειες αυξάνεται σταδιακά 
κατά τη μετάβαση από το 1ο στο 3ο στάδιο 

• Κατά τη μετάβαση από το πρώτο στάδιο στο δεύτερο, η μέγιστη τάση είναι 
περίπου 100πλάσια αυτής του πρώτου σταδίου, ενώ κατά τη μετάβαση από το 
δεύτερο στάδιο στο τρίτο, παρουσιάζει αύξηση 10.3% 

• Η μέγιστη Von Mises παραμόρφωση στις καταγματικές επιφάνειες λαμβάνει 
χώρα κατα το 1ο στάδιο 
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• Η μέγιστη Von Mises παραμόρφωση στις καταγματικές επιφάνειες μειώνεται 
σταδιακά κατά τη μετάβαση από το 1ο στο 3ο στάδιο 

• Κατά τη μετάβαση από το πρώτο στάδιο στο δεύτερο, η μέγιστη 
παραμόρφωση παρουσιάζει μείωση 76%, ενώ κατά τη μετάβαση από το 
δεύτερο στάδιο στο τρίτο, η μείωση ανέρχεται στο 81.4% 

 

7.4.4 Σύνοψη αποτελεσμάτων για τα κατάγματα Κ1, Κ2 και Κ3 

Στον παρακάτω πίνακα φαίνονται συγκεντρωτικά οι τιμές της μέγιστης Von 
Mises τάσης και της μέγιστης Von Mises παραμόρφωσης των καταγματικών 
επιφανειών, για τα κατάγματα Κ1, Κ2 και Κ3, όπως αυτές προέκυψαν για καθένα από 
τα τρία στάδια πώρωσης κατάγματος και όπως αυτές παρουσιάστηκαν στις 
προηγούμενες παραγράφους. 

 

Στάδια Μέγιστη Von Mises 
τάση (MPa) 

Μέγιστη Von Mises 
παραμόρφωση (mstrain) 

 K1 K2 K3 K1 K2 K3 

1ο στάδιο 0,013078 0,016648 0,023622 7,631 9,713 13,782 

2ο στάδιο 1,904 1,539 2,541 2,475 2 3,303 

3ο στάδιο 2,792 3,141 2,834 0,605 0,68 0,614 

 

Πίνακας 5: Σύνοψη τιμών μέγιστης Von Mises τάσης/παραμόρφωσης για τα κατάγματα Κ1, Κ2 και 
Κ3, για καθένα από τα τρία στάδια πώρωσης κατάγματος 

 

 

Στα διαγράμματα 7.7 και 7.8 φαίνονται η μεταβολές της μέγιστης Von Mises 
τάσης και της μέγιστης Von Mises παραμόρφωσης όπως αυτές προέκυψαν για 
καθένα από τα τρία στάδια πώρωσης κατάγματος. 
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Διάγραμμα 7.7: Μεταβολή μέγιστης Von Mises τάσης για τα κατάγματα Κ1, Κ2 και Κ3, για καθένα 
από τα τρία στάδια πώρωσης κατάγματος 

 

 

Διάγραμμα 7.8: Μεταβολή μέγιστης Von Mises παραμόρφωσης για τα κατάγματα Κ1, Κ2 και Κ3, για 
καθένα από τα τρία στάδια πώρωσης κατάγματος 

 

7.4.5 Σύγκριση καταγμάτων 

 
7.4.5.1  Το Κ2 σε σχέση με το Κ1 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 
καταγματικές επιφάνειες του Κ2 είναι κατα 27.3% μεγαλύτερη από τη 
μέγιστη τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 
καταγματικές επιφάνειες του Κ2 είναι κατα 19.2% μικρότερη από τη μέγιστη 
τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 
καταγματικές επιφάνειες του Κ2 είναι κατα 12.5% μεγαλύτερη από τη 
μέγιστη τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ1. 
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• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ2 είναι κατα 27.3% μεγαλύτερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το δεύτερο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ2 είναι κατα 19.2% μικρότερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το τρίτο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ2 είναι κατα 12.4% μεγαλύτερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ1. 

 

7.4.5.2  Το Κ3 σε σχέση με το Κ2 
• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 

καταγματικές επιφάνειες του Κ3 είναι κατα 41.9% μεγαλύτερη από τη 
μέγιστη τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ2. 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 
καταγματικές επιφάνειες του Κ3 είναι κατα 65.1% μεγαλύτερη από τη 
μέγιστη τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ2. 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 
καταγματικές επιφάνειες του Κ3 είναι κατα 9.8% μικρότερη από τη μέγιστη 
τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ2. 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ3 είναι κατα 41.9% μεγαλύτερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ2. 

• Κατά το δεύτερο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ3 είναι κατα 65.2% μεγαλύτερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ2. 

• Κατά το τρίτο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ3 είναι κατα 9.7% μικρότερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ2. 

 

7.4.5.3  Το Κ3 σε σχέση με το Κ1 
• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 

καταγματικές επιφάνειες του Κ3 είναι κατα 80.6% μεγαλύτερη από τη 
μέγιστη τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 
καταγματικές επιφάνειες του Κ3 είναι κατα 33.5% μεγαλύτερη από τη 
μέγιστη τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη τάση που αναπτύσσεται στις 
καταγματικές επιφάνειες του Κ3 είναι κατα 1.5% μεγαλύτερη από τη μέγιστη 
τάση που αναπτύσσεται στις καταγματικές επιφάνειες του Κ1. 



 
89 

 

• Κατά το πρώτο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ3 είναι κατα 80.6% μεγαλύτερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το δεύτερο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ3 είναι κατα 33.5% μεγαλύτερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ1. 

• Κατά το τρίτο στάδιο πώρωσης, η μέγιστη παραμόρφωση που εμφανίζεται 
στις καταγματικές επιφάνειες του Κ3 είναι κατα 1.5% μεγαλύτερη από τη 
μέγιστη παραμόρφωση που εμφανίζεται στις καταγματικές επιφάνειες του Κ1. 

 

7.5 Γενικά συμπεράσματα 

Η σύγκριση των τριών καταγμάτων και των τριών σταδίων πώρωσης τους, 
μας οδηγεί στα εξής συμπεράσματα: 

• Στην πώρωση κατάγματος, κατά τη μετάβαση από το πρώτο στάδιο στο τρίτο, 
η μέγιστη τάση αυξάνεται, ενώ η μέγιστη παραμόρφωση μειώνεται 

• Στο πρώτο στάδιο της πώρωσης, η μεγαλύτερη τάση στις καταγματικές 
επιφάνειες, αναπτύσσεται στο Κ3 και η μικρότερη στο Κ1, ενώ η μεγαλύτερη 
παραμόρφωση, λαμβάνει χώρα στο Κ3 και η μικρότερη στο Κ1 

• Στο δεύτερο στάδιο της πώρωσης, η μεγαλύτερη τάση στις καταγματικές 
επιφάνειες, αναπτύσσεται στο Κ3 και η μικρότερη στο Κ2, ενώ η μεγαλύτερη 
παραμόρφωση, λαμβάνει χώρα στο Κ3 και η μικρότερη στο Κ2 

• Στο τρίτο στάδιο της πώρωσης, η μεγαλύτερη τάση στις καταγματικές 
επιφάνειες, αναπτύσσεται στο Κ2 και η μικρότερη στο Κ1 ενώ η μεγαλύτερη 
παραμόρφωση, λαμβάνει χώρα στο Κ2 και η μικρότερη στο Κ1 

• Η κατανομές των τάσεων και των παραμορφώσεων στο τελευταίο στάδιο της 
πώρωσης, θα διαφέρουν σημαντικά από αυτές ενός φυσιολογικού οστού (που 
δεν έχει υποστεί κάταγμα) 
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Α.  Επεξεργασία αξονικών τομογραφιών στο Mimics 

Στο περιβάλλον εργασίας του Mimics, στη δεξιά πλευρά έχουμε τη 
δυνατότητα να δούμε τις εγκάρσιες τομογραφίες που σαρώθηκαν από τον αξονικό 
τομογράφο και με μετακίνηση της κυλιόμενης μπάρας (δεξιά της τομογραφίας) 
μπορούμε να μεταβούμε σε όποια τομογραφία επιθυμούμε. Στην αριστερή πλευρά, 
αυτό που παρατηρούμε δεν είναι τίποτε άλλο από τις τρισδιάστατες 
ανακατασκευασμένες εικόνες σε δύο επίπεδα, μετωπιαίο όσον αφορά στην πάνω 
εικόνα και οβελιαίο όσον αφορά στην κάτω.  

Για την επεξεργασία των αξονικών τομογραφιών στο Mimics, εργαζόμαστε 
πάνω σε φίλτρα, τα οποία καλούνται μάσκες (masks) και μπορούμε να τα 
διαχειριστούμε με την εντολή Project management (Εικ. Α1). Οι μάσκες, 
αποτελούνται από pixels, τα οποία έχουμε τη δυνατότητα να επεξεργαστούμε μέσω 
της εντολής Edit masks. Το πλεονέκτημα που έχουμε, εργαζόμενοι σε μάσκες, είναι η 
χρήση ξεχωριστής μάσκας σε κάθε βήμα της επεξεργασίας. Αυτό σημαίνει ότι κάθε 
φορά που ολοκληρώνουμε κάποιο βήμα, καλό θα ήταν να δημιουργούμε κάποιο 
αντίγραφο της μάσκας (Duplicate mask) και να εργαζόμαστε πάνω σ’ αυτό κατά το 
επόμενο βήμα επεξεργασίας. 

 
Εικόνα Α1 

 

Για την εξαγωγή της γεωμετρίας του προς επεξεργασία μοντέλου, τα βήματα 
που ακολουθούμε είναι τα εξής: 

• Εισαγωγή των αξονικών τομογραφιών στο Mimics 
• Οργάνωση αξονικών τομογραφιών 
• Καθορισμός των ορίων φωτεινότητας των ιστών 
• Τμηματοποίηση των γραφικών απεικονίσεων της δομής 
• Απομάκρυνση των τμημάτων που είναι εκτός πεδίου ενδιαφέροντος 
• Γραφική επεξεργασία τμημάτων που είναι εντός περιοχής ενδιαφέροντος 
• Προεπισκόπηση γεωμετρίας μοντέλου 
• Βελτιστοποίηση γεωμετρίας μοντέλου 
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Εισαγωγή των αξονικών τομογραφιών: File>Import STL 

Οργάνωση αξονικών τομογραφιών: File>Organize Images (Εικ. Α2) 

 
Εικόνα Α2 

 

Πληροφορίες σχετικά με τον αξονικό τομογράφο, το μέγεθος των τομογραφιών κλπ: 
File>Project information (Εικ. Α3) 

 
Εικόνα Α3 

 

Ο καθορισμός των ορίων φωτεινότητας, είναι πολύπλοκος και έχει άμεση 
σχέση και με την πυκνότητα των ιστών. Γενικά, στις αξονικές τομογραφίες, εκτός 
από τα οστά, διακρίνονται και άλλοι ιστοί (χόνδροι, μαλακός ιστός, κλπ) οι οποίοι 
πρέπει να απομονωθούν και να απομακρυνθούν γραφικά. Κατά τη σάρωση όλοι οι 
ιστοί απορροφούν ακτινοβολία. Τα οστά απορροφούν περισσότερη ακτινοβολία απ’ 
ότι οι υπόλοιποι ιστοί, γι’ αυτό και φαίνονται πιο φωτεινά στις τομογραφίες. Οι 
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μαλακοί ιστοί αποτυπώνονται με σχεδόν γκρι χρώμα, ενώ με μαύρο χρώμα 
αποτυπώνεται η ακτινοβολία που προσέπεσε στο κενό. Τα όρια φωτεινότητας, τα 
καθορίζει ο χρήστης μέσω της εντολής Segmentation>Thresholding (Εικ. Α4), οπότε 
και καθορίζονται ένα άνω κι ένα κάτω όριο φωτεινότητας (για οστά ένα τυπικό 
σύνολο τιμών είναι [240-3071]). Αυτό έχει σαν αποτέλεσμα τη γραφική 
απομάκρυνση όλων των pixels που βρίσκονται εκτός του πεδίου φωτεινότητας. 

 

 
Εικόνα Α4 

 

Με την εντολή Region growing έχουμε τη δυνατότητα να επιλέξουμε όλα τα 
pixels εντός των ορίων φωτεινότητας που συνορεύουν μεταξύ τους. Αυτό βοηθάει 
στο να επιλέξουμε τα τμήματα που θα συμπεριλαμβάνονται στην τελική γεωμετρία, 
απομακρύνοντας αυτά που δε μας ενδιαφέρουν. Κατα την εκτέλεση της εντολής 
αυτής, φροντίζουμε να είναι ενεργή η επιλογή Keep original mask, έτσι ώστε το 
αποτέλεσμα, μετά την εκτέλεση της εντολής Region growing, να καταγραφεί σε νέα 
μάσκα. 

Το κάθε οστό, πρέπει να εισαχθεί στο ANSYS σαν ξεχωριστή οντότητα και 
για τον λόγο αυτό πρέπει να γίνει ο διαχωρισμός τους στο Mimics. Pixels εντός των 
ορίων φωτεινότητας, τα οποία «ενώνουν» τα οστά, πρέπει να απομακρύνονται και 
αυτό επιτυγχάνεται μέσω της εντολής Erase, ενώ μπορούμε να εργαζόμαστε 
παράλληλα και στα τρία επίπεδα (εγκάρσιο, μετωπιαίο, οβελιαίο). 

Τα κενά τμήματα, που αντιστοιχούν στο εσωτερικό των οστών, 
αντιπροσωπεύουν τις περιοχές σπογγώδους οστού, το οποίο, λόγω μικρής 
πυκνότητας, βρίσκεται εκτός των ορίων φωτεινότητας. Για την εξαγωγή της 3D 
γεωμετρίας, τα οστά πρέπει να είναι συμπαγή, να έχουν δηλαδή ενιαίο όγκο, γι’ αυτό 
και πρέπει να αποκτήσουν, σε όλη τους την έκταση, μία τιμή φωτεινότητας εντός των 
επιλεγμένων ορίων. Αυτό, πρακτικά σημαίνει ότι τα κενά pixels (τα οποία είναι 
μαύρα στην τρέχουσα μάσκα), πρέπει να πάρουν το χρώμα της τρέχουσας μάσκας, 
και αυτό θα γίνει με την εντολή Draw. 
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Προεπισκόπηση της γεωμετρίας επιτυγχάνεται με την εντολή Calculate 3D 
from mask, εφόσον η μάσκα είναι επιλεγμένη στο tab masks του project Management 
(Εικ. Α5). Η γεωμετρία των οστών αναπαρίσταται με τρίγωνα, τα οποία όμως είναι 
πολύ μικρά σε μέγεθος κι έτσι δεν είναι ορατά μέσα σε αυτό το γραφικό περιβάλλον. 

Όταν φτάσουμε στο σημείο όπου η τελική γεωμετρία είναι και η επιθυμητή, 
πρέπει να κάνουμε διάφορες ενέργειες με σκοπό τη βελτιστοποίησή της. Έτσι, από το 
tab 3D objects, επιλέγουμε την τρισδιάστατη γεωμετρία που θέλουμε να 
βελτιστοποιήσουμε και έπειτα Actions>Remesh (Εικ. Α6). Τότε οδηγούμαστε σε ένα 
άλλο γραφικό περιβάλλον (Meshing module), όπου θα απομακρύνουμε τις περιττές 
λεπτομέρειες της γεωμετρίας, και θα μειώσουμε τον αριθμό των τριγώνων, 
διατηρώντας όμως την ποιότητά τους. Τα βήματα που ακολουθούμε είναι τα εξής: 

• Tools>Smoothing: Επιτυγχάνουμε εξομάλυνση της γεωμετρίας 
• Triangle reduction>Normal>Point: Επιτυγχάνουμε μείωση των τριγώνων (Εικ. 

Α7) 
• Triangle reduction>Normal>Edge: Επιτυγχάνουμε μείωση των τριγώνων 
• Auto remesh>Optimize-Based method: Δημιουργία νέου πλέγματος, σύμφωνα 

με τις προϋποθέσεις των βημάτων 1,2 και 3 (Εικ. Α8) 
• Triangle reduction>Quality preserving: Μείωση των τριγώνων με ταυτόχρονη 

διατήρηση της ποιότητας του πλέγματος (Εικ. Α9) 
• File>Exit Meshing module: Οδηγούμαστε πίσω στο περιβάλλον του Mimics 

 

                                                    
Εικόνα Α5                                                                       Εικόνα Α6 

 

                                                   
Εικόνα Α7                                                                        Εικόνα Α8 
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Εικόνα Α9 

 

Η βελτιστοποιημένη γεωμετρία θα έχει το πρόθεμα Remeshed_ και είναι αυτή που 
τελικά θα εισαχθεί στο ANSYS (Εικ. Α10). Έτσι, επιλέγοντας Export>Ansys 
οδηγούμαστε σε ένα παράθυρο, όπου πρέπει να επιλέξουμε τη βελτιστοποιημένη 
γεωμετρία, η οποία θα εξαχθεί από το Mimics υπό τη μορφή Ansys Area Files (.lis) 
(Εικ. Α11). 

                                
Εικόνα Α10                                                                                   Εικόνα Α11 
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Β.  Μοντελοποίηση στο ANSYS/LS-DYNA 

Για να εισάγουμε την 3D γεωμετρία στο ANSYS, επιλέγουμε File>Read input 
from και επιλέγουμε το αρχείο .lis της βελτιστοποιημένης γεωμετρίας που 
δημιουργήσαμε στο Mimics (Εικ. Β1). Έτσι, εισάγεται η εξωτερική επιφάνεια της 
γεωμετρίας, τμηματοποιημένη σε τριγωνικά στοιχεία, και το ANSYS αναγνωρίζει 
μόνο επιφάνειες, και ότι αυτές συμπαρασέρνουν (lines, keypoints), οι οποίες στη 
συνέχεια πρέπει να ορισθούν σαν ενιαίοι όγκοι. 

 
Εικόνα Β1 

 

Τα αρχεία που δημιουργούνται στο ANSYS είναι αρχεία δεδομένων (.db). Τα 
βήματα που ακολουθούμε για τη μοντελοποίηση μιας γεωμετρίας, είναι τα εξής: 

• Εισαγωγή της γεωμετρίας 
• Καθορισμός του φυσικού φαινομένου και επιλογή της μεθόδου επίλυσης 
• Επιλογή στοιχείων (Elements) 
• Ορισμός ιδιοτήτων υλικού (Material Properties) 
• Επεξεργασία μοντέλου (Modeling) 
• Πλεγματοποίηση (Meshing) 
• Ορισμός επαφής επιφάνειας με επιφάνεια (Contact) 
• Επιβολή οριακών συνθηκών (Constraints) 
• Επιβολή φορτίσεων (Loads) 
• Ορισμός παραμέτρων επίλυσης 
• Επίλυση (Solve) 
• Ανάγνωση αποτελεσμάτων 
• Επεξεργασία αποτελεσμάτων 
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Η γεωμετρία, μπορεί να προέρχεται από κάποιο πρόγραμμα επεξεργασίας 
εικόνων, με τη μορφή .lis, ή μπορεί επίσης να δημιουργηθεί μέσα στο ANSYS, 
αρχικά δημιουργώντας κρίσιμα σημεία (keypoints), και από αυτά γραμμές, από τις 
οποίες παράγονται στη συνέχεια επιφάνειες, από τις οποίες, τελικά, ορίζονται οι 
όγκοι. Οι εντολές που χρησιμοποιούνται για το σκοπό αυτό είναι: 

ANSYS Main Menu>Preprocessor>Modeling>Create>Keypoints για τη δημιουργία 
κρίσιμων σημείων ελέγχου, και αντίστοιχα, Lines για τη δημιουργία γραμμών, Areas 
για τη δημιουργία επιφανειών και Volumes για τη δημιουργία όγκων (Εικ. Β2). 

 
Εικόνα Β2 

 

Σε αυτό το σημείο, πρέπει να σημειώσουμε ότι το ANSYS δεν παρέχει τη 
δυνατότητα  επιστροφής σε προηγούμενη ενέργεια, σε περίπτωση λάθους. Για τον 
λόγο αυτό πρώτο μας μέλημα μετά την ολοκλήρωση μιας ενέργειας είναι το 
«σώσιμο» των δεδομένων, το οποίο γίνεται απ’ το ANSYS Toolbar, με την επιλογή 
SAVE_DB (Εικ. Β3). Ακριβώς δίπλα, υπάρχει το RESUME_DB, η εκτέλεση του 
οποίου έχει σαν αποτέλεσμα την επαναφορά στην τελευταία σωσμένη βάση 
δεδομένων. Επίσης, υπάρχουν οι δυνατότητες Move (Ctrl+αριστερό κλικ), Rotate 
(Ctrl+δεξί κλικ), Zoom, Zoom-fit, κλπ. 

 
Εικόνα Β3 
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Μετά την εισαγωγή της γεωμετρίας πρέπει να δηλώσουμε το είδος του 
φαινομένου που θα προσομοιωθεί (για να περιοριστούν οι παράμετροι της 
μοντελοποίησης γύρω από αυτό), και τη μέθοδο επίλυσης (h-Method για στατικό 
πρόβλημα, LS-DYNA Explicit για δυναμικό πρόβλημα). Αυτό, γίνεται από το 
ANSYS Main Menu, επιλέγοντας Preferences (Εικ. Β4). 

 
Εικόνα Β4 

 

Επόμενο βήμα, είναι η επιλογή των στοιχείων που θα χρησιμοποιηθούν για 
την τμηματοποίηση της γεωμετρίας, και για να γίνει αυτό, πρέπει να οδηγηθούμε στη 
βιβλιοθήκη στοιχείων (Library of Element Types), και να τα επιλέξουμε (Εικ. Β5). 
Αυτό, γίνεται από το ANSYS Main Menu, ακολουθώντας τη διαδρομή: 

Preprocessor>Element Type>Add/Edit/Delete>Add 

 
Εικόνα Β5 

 

Έπειτα, πρέπει να ορίσουμε τις ιδιότητες των υλικών από τα οποία 
αποτελείται το μοντέλο (οστά, χόνδροι, σύνδεσμοι). Για παράδειγμα, ένα υλικό, 
μπορεί να οριστεί ως ισότροπο, ανισότροπο, υπερελαστικό, κλπ. Αυτό, γίνεται από το 
ANSYS Main Menu, ακολουθώντας τη διαδρομή: 

Preprocessor>Material Props>Material Models 

και αφού ορίσουμε τις ιδιότητες (π.χ. LS-DYNA>Linear>Elastic>Isotropic), πρέπει 
να δηλώσουμε τιμές για το μέτρο ελαστικότητας (Ex) και τον λόγο Poisson (ߥ) (Εικ. 
Β6). 



 
102 

 

 
Εικόνα Β6 

 

Αφού οριστούν αυτά, επόμενο βήμα είναι η επεξεργασία της γεωμετρίας. 
Όλες οι διεργασίες που έχουν σχέση με αυτό, γίνονται από το ANSYS Main Menu, 
με την επιλογή Preprocessor. 

Για μια δεδομένη γεωμετρία, όπως αυτή που εξήχθη από το Mimics, πρώτη 
ενέργεια, είναι ο ορισμός των ενιαίων οντοτήτων της γεωμετρίας. Αυτό πρακτικά 
σημαίνει ότι από τις υπάρχουσες επιφάνειες, πρέπει να παραχθούν όγκοι. Αυτό 
επιτυγχάνεται με επιλέγοντας Modeling>Create >Volumes>Arbitrary>By Areas. Αν 
με Loop, επιλέξουμε μία επιφάνεια κάποιας οντότητας, τότε επιλέγονται αυτόματα 
όλες οι επιφάνειες της οντότητας, και (πατώντας OK) ορίζεται στο ANSYS ο όγκος 
που περικλείουν οι επιφάνειες (Εικ. Β2). 

Αφού δημιουργηθούν οι όγκοι των οστών, πρέπει να μοντελοποιηθούν οι 
αρθρικοί  χόνδροι (οι οποίοι θυμίζουμε πως αφαιρέθηκαν κατά την επεξεργασία στο 
Mimics). Για τη μοντελοποίηση του αρθρικού χόνδρου, πρέπει να δημιουργήσουμε 
έναν όγκο, ανάμεσα σε δύο οστά. Γι’ αυτό, πρέπει πρώτα να επιλέξουμε τις αρθρικές 
επιφάνειες, οι οποίες θα περικλείουν τον όγκο. Αυτό, επιτυγχάνεται επιλέγοντας 
Select>Entities>Areas>Reselect>OK και επιλέγουμε μία-μία τις επιφάνειες που θα 
ορίζουν την πρώτη αρθρική επιφάνεια. Έπειτα, επιλέγοντας 
Select>Entities>Areas>Also Select>OK επιλέγουμε μία-μία τις επιφάνειες που θα 
ορίζουν τη δεύτερη αρθρική επιφάνεια. Μετά επιλέγουμε Select>Everything 
Below>Selected Areas και τέλος Plot>Areas. Με τον τρόπο αυτό, έχουμε επιλεγμένες 
τις επιφάνειες των δύο οστών, οι οποίες θα αποτελούν τι αρθρικές επιφάνειες. Αυτές, 
θα μπορέσουν να ορίσουν όγκο, μόνο αν τις «κλείσουμε», και αυτό πρακτικά 
σημαίνει ότι πρέπει να δημιουργήσουμε επιφάνειες που θα ενώνουν τις επιλεγμένες 
αρθρικές επιφάνειες. Ο γρηγορότερος τρόπος για να γίνει αυτό είναι επιλέγοντας 
Modeling>Create >Areas>Arbitrary>Through KPs και επιλέγουμε διαδοχικά δύο 
keypoints της μίας επιφάνειας και δύο keypoints της άλλης. Έτσι, έχουμε 
δημιουργήσει μία non-planar επιφάνεια (παρεμβολή Coons) και στόχος είναι να 
δημιουργήσουμε και τις υπόλοιπες, ώστε να μπορέσουμε να ορίσουμε τον όγκο (Εικ. 
Β7). 
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Εικόνα Β7
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Με εκτέλεση της εντολής Modeling>Operate>Booleans>Add>Volumes και 
επιλογή των όγκων αυτών, ορίζεται στο ANSYS ο όγκος του αρθρικού χόνδρου σαν 
ενιαία οντότητα (Εικ. Β9). Τέλος, ο δεύτερος αρθρικός χόνδρος, ορίζεται σύμφωνα 
με αυτά που αναφέρθηκαν στην προηγούμενη παράγραφο. 

 

 
Εικόνα Β9 

 

Μέχρι στιγμής, η γεωμετρία μας περιλαμβάνει όγκους, δηλαδή τα οστά και 
τους χόνδρους. Μετά την τοποθέτηση του πλέγματος, θα προστεθούν στη γεωμετρία 
και οι σύνδεσμοι. Όσον αφορά στους συνδέσμους, η ένταξή τους στη γεωμετρία, 
επιτυγχάνεται με τη δημιουργία γραμμών, την απόδοση ιδιοτήτων συνδέσμου σε 
αυτές, και φυσικά τον ορισμό του ανάλογου στοιχείου για τη μοντελοποίηση των 
συνδέσμων. 

Η πλεγματοποίηση γίνεται είτε ξεχωριστά σε κάθε οντότητα, είτε ταυτόχρονα 
στο σύνολο των οντοτήτων ίδιου υλικού. Με την επιλογή Modeling>Meshing>Mesh 
Tool ανοίγει ένα παράθυρο στο οποίο στο οποίο εργαζόμαστε για να δημιουργήσουμε 
το πλέγμα. Εκεί, όσον αφορά στα Element Attributes, επιλέγουμε Volumes>Set και 
έπειτα επιλέγουμε τους όγκους ίδιου υλικού, που θα αποτελούνται από τον ίδιο τύπο 
στοιχείου, και έπειτα, ορίζουμε το υλικό και τον τύπο του στοιχείου. Το μέγεθος των 
στοιχείων, μπορεί να καθοριστεί από το Size Controls του Mesh Tool. Αφού 
καθοριστούν αυτές οι παράμετροι, δηλώνουμε ότι το πλέγμα θα μπει σε όγκους 
(Mesh: Volumes) και επιλέγουμε Mesh και έπειτα τους όγκους, των οπoίων το 
πλέγμα θα αποτελείται από τον συγκεκριμένο τύπο στοιχείου (Εικ. Β10). Όσον 
αφορά στους συνδέσμους, ακολουθείται η ίδια διαδικασία, μόνο που εδώ έχουμε να 
κάνουμε με Lines (για τα Attributes και για το Mesh). 
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Εικόνα Β10 

 

Με την ολοκλήρωση αυτού του βήματος, το μοντέλο μας περιλαμβάνει οστά, 
χόνδρους, συνδέσμους, και έχουμε ορίσει όγκους και στοιχεία (άρα και κόμβους). 
Όλα αυτά, μπορούμε να τα δούμε είτε στην περιοχή σχεδίασης του ANSYS 
επιλέγοντας Select>Entities (Εικ. Β11), είτε σε λίστα επιλέγοντας List και έπειτα την 
οντότητα που επιθυμούμε. 

 
Εικόνα Β11 

 

Η επαφή επιφάνειας με επιφάνεια, συνήθως δηλώνεται όταν έρχονται σε 
επαφή δύο αρθρικοί χόνδροι, και δεν είναι τίποτε άλλο από έναν καθορισμό δύο 
επιφανειών που θα αλληλεπιδρούν. Αυτό, λέγεται Contact. Για τον ορισμό του 
Contact, πρέπει να δημιουργήσουμε Components αποτελούμενα από κόμβους. 
Πρόκειται για σύνολα κόμβων, όπου κάθε σύνολο θα αποτελεί μία ομάδα με 
συγκεκριμένο όνομα. Έτσι, για παράδειγμα, επιλέγουμε έναν αρθρικό χόνδρο, εκ των 
δύο (Select>Entities>Volumes, Select>Everything Below>Selected Volumes, 
Plot>Elements), επιλέγουμε τους κόμβους από τους οποίους αποτελείται 
(Plot>Nodes, Select>Entities>Nodes>Reselect>OK, Pick All) και δημιουργούμε 
Component, αποτελούμενο από όλους τους κόμβους του αρθρικού χόνδρου, ως εξής: 
Select>Component Assembly>Create Component και αφού ονοματίσουμε και 
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ορίσουμε ότι αποτελείται από κόμβους, επιλέγουμε Apply (Εικ. Β12). Το ίδιο πρέπει 
να κάνουμε για όλους εκείνους τους αρθρικούς χόνδρους στους οποίους θα ορίσουμε 
Contact. Η διαχείριση των Components, γίνεται από τον Component Manager του 
ANSYS (Select>Component Manager) (Εικ. Β13). 

                      
Εικόνα Β12                                                                                Εικόνα Β13 

 
 

Για τον ορισμό του Contact, θα πρέπει να δηλώσουμε ποια Components θα 
αλληλεπιδράσουν. Έτσι, από το ANSYS Main Menu επιλέγουμε Preprocessor>LS-
DYNA Options>Contact>Define Contact και έπειτα καθορίζουμε τον τύπο της 
επαφής, ο οποίος είναι “surface to surface” και τέλος, επιλέγοντας Apply ορίζουμε 
ένα Contact για κάθε δύο Components που αλληλεπιδρούν (Εικ. Β14). 

 
Εικόνα Β14 

 

Σε αυτό το σημείο, έχει ολοκληρωθεί η προεπεξεργασία του μοντέλου και 
ακολουθούν οι ενέργειες που πρέπει να γίνουν για την επίλυση του προβλήματος. 
Σειρά λοιπόν έχει η επιβολή των εξωτερικών δράσεων, η οποίες, στην Explicit 
Dynamics ανάλυση είναι χρονοεξαρτώμενες. Αυτό σημαίνει ότι η δύναμη και ο 
χρόνος, συνδέονται με μία ορισμένη συνάρτηση, και ότι ορίζονται η έναρξη επιβολής 
δύναμης (birth time) και η λήξη επιβολής δύναμης (death time). Αυτό πρακτικά 
ορίζεται παραμετρικά και συγκεκριμένα με τη δημιουργία μητρώων, ένα για τον 
χρόνο και ένα για κάθε δράση, τα στοιχεία των οποίων είναι σε αντιστοιχία: 
Parameters>Array Parameters>Define/Edit (Εικ. Β15). 



 
107 

 

 
Εικόνα Β15 

 

Μετά τη δημιουργία των μητρώων, ακολουθεί η δημιουργία Components 
(Node Components), ένα για κάθε δύναμη, που θα αποτελούν τα σημεία εφαρμογής 
των δυνάμεων. Η επιβολή των δυνάμεων γίνεται ως εξής: Preprocessor>LS-DYNA 
Options>Loading Options>Specify Loads όπου ορίζονται η διεύθυνση της δύναμης, 
τα μητρώα δύναμης και χρόνου που δημιουργήθηκαν καθώς και το σημείο εφαρμογής 
της αντίστοιχης δύναμης, το Component δηλαδή που δημιουργήθηκε για τον σκοπό 
αυτόν (Εικ. Β16). 

 
Εικόνα Β16 

 

Μόλις ολοκληρωθεί και αυτή η διαδικασία, επιβάλλονται οι οριακές συνθήκες 
ως εξής: Preprocessor>LS-DYNA Options>Constraints>Apply. Οι οριακές συνθήκες 
επιβάλλονται είτε σε γεωμετρικά στοιχεία (γραμμές, επιφάνειες), είτε σε κόμβους. 

Τέλος, αφού καθοριστεί ο συνολικός χρόνος επίλυσης (Solution>Time 
Controls>Solution Time) ξεκινάει η επίλυση επιλέγοντας Solution>Solve. 

 

Με την ολοκλήρωση της επίλυσης, τα αποτελέσματα αποθηκεύονται σε ένα 
ξεχωριστό αρχείο (.rst) και για την καταγραφή τους πρέπει να επιλέξουμε από το 
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ANSYS Main Menu: General Postproc>Read Results>First Set. Έπειτα, για την 
επεξεργασία των αποτελεσμάτων και την παρουσίασή τους στο γραφικό περιβάλλον 
του ANSYS, πρέπει πρώτα να επιλέξουμε PlotCtrls>Animate>Over Results και μόνο 
όταν ολοκληρωθεί και αυτή η διαδικασία και επιλέγοντας General Postproc>Plot 
Results, είμαστε έτοιμοι να διαβάσουμε τα αποτελέσματα (Εικ. Β17). 

 
Εικόνα Β17 

 

Η ανάγνωση των αποτελεσμάτων μπορεί να γίνει με τη λήψη αποτελεσμάτων 
στους κόμβους (Nodal solution) ή στα στοιχεία (Element solution). Στην πρώτη 
περίπτωση δίνεται στους κόμβους η τιμή του μέσου όρου που προκύπτει από τα 
πεπερασμένα στοιχεία στα οποία είναι κοινός, ενώ στη δεύτερη δίνεται μία τιμή ανά 
πεπερασμένο στοιχείο (Εικ. Β18). Η ανάγνωση, μπορεί επίσης να γίνει με την 
επιλογή Element Table, που αφορά στη διαδικασία ομαλοποίησης των 
αποτελεσμάτων υπολογίζοντας μέσους όρους. 

 
Εικόνα Β18 

 

 

 


